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chapter 1

Welcome to Pro Tools|HD
Welcome to Pro Tools|HD®. Pro Tools|HD audio 
cards and interfaces bring high-definition digi-
tal audio recording, editing, signal processing, 
mixing, and I/O capabilities to Pro Tools.

This guide covers installation and configuration 
of Pro Tools|HD hardware and Pro Tools® soft-
ware on Windows and Mac platforms. 

Pro Tools|HD Systems
Pro Tools software supports the following sys-
tems:

Pro Tools|HD (for PCIe) Systems

Pro Tools|HD (for PCIe) systems are available in 
the following configurations:

Pro Tools|HD 1 (for PCIe)

• Accel Core (for PCIe) card

Pro Tools|HD 2 Accel (for PCIe)

• Accel Core (for PCIe) card

• HD Accel (for PCIe) card

Pro Tools|HD 3 Accel (for PCIe)

• Accel Core (for PCIe) card

• Two HD Accel (for PCIe) cards
Pro Tools|HD (for PCI) Systems

Pro Tools|HD (for PCI) systems are available in 
the following configurations:

Pro Tools|HD 1 (for PCI)

• HD Core (for PCI) card

Pro Tools|HD 2 Accel (for PCI)

• HD Core (for PCI) card

• HD Accel (for PCI) card

Pro Tools|HD 3 Accel (for PCI)

• HD Core (for PCI) card

• Two HD Accel (for PCI) cards

Pro Tools also supports earlier Pro Tools|HD 
2 (for PCI) and Pro Tools|HD 3 (for PCI) sys-
tems. These systems shipped with HD Pro-
cess cards instead of HD Accel cards

Pro Tools HD supports more than three HD 
cards in certain system configurations. For 
more information, see the Expanded Sys-
tems Guide. 
Chapter 1: Welcome to Pro Tools|HD 1
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Pro Tools|HD System 
Packages
All Pro Tools|HD systems include the following:

• Pro Tools|HD card(s)

• Pro Tools Installer disc containing 
Pro Tools software, DigiRack™ TDM, 
RTAS™ (Real-Time AudioSuite), and Audio-
Suite™ plug-ins

• Pre-authorized iLok for running 
Pro Tools HD

• This Setup Guide, covering installation and 
configuration of Pro Tools|HD systems

• Pro Tools Reference Guide and other docu-
mentation

• DigiLink cable for connecting the primary 
card to an audio interface

• TDM FlexCables (multi-card systems only) 
to connect the cards to each other

• Digidesign Registration Information Card

All Pro Tools|HD systems also require at least 
one Digidesign® audio interface (sold sepa-
rately). See “Audio Interfaces” on page 6.

For more information on the print, elec-
tronic, and web-based resources available 
to help you use Pro Tools, see Appendix H, 
“Resources.”
Pro Tools|HD Setup Guide
Pro Tools HD Capabilities
Pro Tools HD on Windows or Mac provides the 
following capabilities:

• Up to a total of 256 audio tracks, 
160 Auxiliary Input tracks, 64 Master Fader 
tracks, 128 VCA Master tracks, 256 MIDI 
tracks, 128 Instrument tracks, and 64 video 
tracks per session

• 16-bit or 24-bit audio resolution, at sample 
rates up to 192 kHz

• Non-destructive, random-access editing 
and mix automation

• Audio processing with up to 10 TDM or 
RTAS plug-ins per track, depending on your 
computer’s capabilities

• Up to 10 hardware inserts per track

• Up to 10 sends per track

• Up to 128 internal busses for routing and 
mixing

The number of simultaneous tracks of audio re-
cording or playback depends on the type of 
Pro Tools|HD system. 



Audio Recording and Playback 
Capabilities

Pro Tools|HD 1 (for PCIe and PCI)

Pro Tools|HD 1 systems provide recording and 
playback of 24-bit or 16-bit audio files with the 
following track counts:

• Up to 96 tracks at 44.1 kHz or 48 kHz

• Up to 48 tracks at 88.2 kHz or 96 kHz

• Up to 18 tracks (for PCIe) or 12 tracks (for 
PCI) at 176.4 kHz or 192 kHz

Pro Tools|HD 2 Accel and HD 3 Accel
(for PCIe and PCI)

Pro Tools|HD 2 Accel and HD 3 Accel systems 
provide recording and playback of 24-bit or 
16-bit audio files with the following track 
counts:

• Up to 192 tracks at 44.1 kHz or 48 kHz

• Up to 96 tracks at 88.2 kHz or 96 kHz

• Up to 36 tracks at 176.4 kHz or 192 kHz

Non-HD Accel Systems
(for PCI)

Pro Tools|HD 2 and HD 3 systems (original 
Pro Tools|HD systems with no HD Accel cards) 
provide recording and playback of 24-bit or 
16-bit audio files with the following track 
counts:

• Up to 128 tracks at 44.1 kHz or 48 kHz

• Up to 64 tracks at 88.2 kHz or 96 kHz

• Up to 24 tracks at 176.4 kHz or 192 kHz
Pro Tools Hardware Overview
This section describes each hardware compo-
nent of a Pro Tools|HD system. The number of 
Pro Tools|HD cards in your system will differ de-
pending on your system configuration. 

Pro Tools|HD (for PCIe) Hardware

Accel Core (for PCIe) Card

All Pro Tools|HD (for PCIe) systems include an 
Accel Core (for PCIe) card. 

The Accel Core (for PCIe) card provides up to 96 
tracks of direct-to-disk recording and playback, 
as well as DSP power for mixing and plug-in pro-
cessing. The Accel Core (for PCIe) card supports 
up to 24-bit and up to 192 kHz sessions.

DigiLink Port The Accel Core (for PCIe) card in-
cludes a single DigiLink port for connecting up 
to 32 channels of audio input and output to 
your Pro Tools|HD system. 

DigiSerial Port The DigiSerial port on the 
Accel Core (for PCIe) card is for connecting a 
Digidesign SYNC peripheral. This connector is 
an 8-pin mini-DIN.

Accel Core (for PCIe) card

The DigiSerial port on an Accel Core 
(for PCIe) card does not support Machine-
Control connections.

DigiLink

DigiSerial 
Chapter 1: Welcome to Pro Tools|HD 3
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HD Accel (for PCIe) Card

The HD Accel (for PCIe) card is included in 
Pro Tools|HD 2 Accel (for PCIe) and 
Pro Tools|HD 3 Accel (for PCIe) systems. The 
HD Accel (for PCIe) card is an expansion card, 
and requires the presence of at least one Accel 
Core (for PCIe) card. 

The HD Accel (for PCIe) card provides addi-
tional channels of direct-to-disk recording and 
playback, as well as additional DSP power for 
mixing and plug-in processing. The HD Accel 
(for PCIe) card supports sessions up to 24-bit 
and up to 192 kHz. 

DigiLink Port The HD Accel (for PCIe) card in-
cludes a single DigiLink port for connecting up 
to 32 channels of audio input and output to 
your Pro Tools|HD system. 

DigiSerial Port The DigiSerial port on the HD Ac-
cel (for PCIe) card does not offer any functional-
ity.

HD Accel (for PCIe) card

DigiLink
Pro Tools|HD Setup Guide
Pro Tools|HD (for PCI) Hardware

HD Core (for PCI) Card

All Pro Tools|HD (for PCI) systems include an 
HD Core (for PCI) card. 

The HD Core (for PCI) card provides up to 96 
tracks of direct-to-disk recording and playback, 
as well as DSP power for mixing and plug-in pro-
cessing. The HD Core (for PCI) card supports up 
to 24-bit and up to 192 kHz sessions.

DigiLink Port The HD Core (for PCI) card in-
cludes a single DigiLink port for connecting up 
to 32 channels of audio input and output to 
your Pro Tools|HD system. 

DigiSerial Port The DigiSerial port on the HD 
Core (for PCI) card is for connecting a Digide-
sign SYNC peripheral. This connector is an 8-pin 
mini-DIN.

HD Core (for PCI) card

The DigiSerial port on an HD Core (for PCI) 
card does not support MachineControl con-
nections.

If your HD Core (for PCI) card has two 
DigiSerial ports, use the DigiSerial port clos-
est to the DigiLink connector.

DigiLink

DigiSerial 



HD Accel (for PCI) Card

The HD Accel (for PCI) card is included in 
Pro Tools|HD 2 Accel (for PCI) and 
Pro Tools|HD 3 Accel (for PCI) systems. The 
HD Accel (for PCI) card is an expansion card, 
and requires the presence of at least one 
HD Core (for PCI) card. 

The HD Accel (for PCI) card provides additional 
tracks of direct-to-disk recording and playback, 
as well as additional DSP power for mixing and 
plug-in processing. The HD Accel (for PCI) card 
supports sessions up to 24-bit and up to 
192 kHz. 

DigiLink Port The HD Accel (for PCI) card in-
cludes a single DigiLink port for connecting up 
to 32 channels of audio input and output to 
your Pro Tools|HD system. 

DigiSerial Port The DigiSerial port on the HD Ac-
cel (for PCI) card does not offer any functional-
ity. 

HD Accel (for PCI) card

DigiLink
TDM FlexCable

The TDM FlexCable is used to connect a pair of 
cards in your Pro Tools system so they can share 
data along the TDM bus. One FlexCable comes 
with each expansion card.

The TDM FlexCable is a flexible printed cir-
cuit board with delicate traces. Do not over-
bend, twist, or pinch the cable. Doing so 
may cause unpredictable behavior in 
Pro Tools as well as harm to your system.

TDM FlexCable
Chapter 1: Welcome to Pro Tools|HD 5
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Audio Interfaces

To record and play audio you must have at least 
one of the following Digidesign audio inter-
faces:

192 I/O Audio Interface

• Supports sample rates up to 192 kHz. (At least 
one 192 I/O™ or 192 Digital I/O™ must be 
connected to your Pro Tools|HD system for 
192 kHz recording, processing, and playback.)

• Supports both analog and digital connections, 
including AES/EBU, S/PDIF, TDIF, and ADAT 
Optical:

• Digital (Digital I/O Card): 8 channels, DB-
25 (AES/EBU and TDIF), or one pair of 
Lightpipe (ADAT Optical) connectors. Ex-
pandable up to 16 channels digital I/O with 
the addition of the 192 Digital expansion 
card.

• Analog: 8 channels, DB-25 (balanced) con-
nectors, inputs selectable between +4 dBu 
or –10 dBV, outputs +4 dBu only. Expand-
able up to 16 analog inputs or 16 outputs 
using an optional 192 AD or 192 DA ex-
pansion card, respectively.

• Digital (Enclosure): 2 channels, XLR 
(AES/EBU) connectors; 2 channels RCA 
(S/PDIF) connectors.

• Optical (Enclosure): 8 channels, one pair of 
Lightpipe (ADAT Optical) connectors (swit-
chable to 2 channels, S/PDIF).

• Loop Sync In and Out for connecting 
Pro Tools|HD interfaces and peripherals

• External Clock In and Out receive or send 1x 
Word clock (configurable to 256x for Legacy 
support, see “Optional Legacy I/O Audio In-
terfaces” on page 7).
Pro Tools|HD Setup Guide
192 Digital I/O Audio Interface

• Supports sample rates up to 192 kHz. (At least 
one 192 I/O or 192 Digital I/O must be con-
nected to your Pro Tools|HD system for 
192 kHz recording, processing, and playback.)

• Supports digital connections, including 
AES/EBU, S/PDIF, TDIF, and ADAT Optical:

• Digital (2 Digital I/O Cards): 16 channels, 
DB-25 (AES/EBU and TDIF), or two pairs of 
Lightpipe (ADAT Optical) connectors.

• Digital (Enclosure): 2 channels, XLR 
(AES/EBU) connectors; 2 channels RCA 
(S/PDIF) connectors.

• Optical (Enclosure): 8 channels, one pair of 
Lightpipe (ADAT Optical) connectors (se-
lectable to 2 channels, S/PDIF).

• Loop Sync In and Out for connecting 
Pro Tools|HD interfaces and peripherals

• External Clock In and Out receive or send 1x 
Word clock (configurable to 256x for Legacy 
support, see “Optional Legacy I/O Audio In-
terfaces” on page 7).



96 I/O Audio Interface

• Supports sample rates up to 96 kHz.

• Supports analog and digital connections, in-
cluding AES/EBU, S/PDIF, and ADAT optical:

• Analog: 8 channels, 1/4-inch TRS (balanced 
or unbalanced) connectors, +4 dBu or 
–10 dBV

• Digital: 2 channels, XLR (AES/EBU) con-
nectors; 2 channels, RCA (S/PDIF) connec-
tors

• Optical: 8 channels, one pair of Lightpipe 
(ADAT Optical) connectors (switchable to 2 
channels, S/PDIF)

• External Clock In and Out receive or send 
1x Word clock (configurable to 256x for 
Legacy support, see “Optional Legacy I/O 
Audio Interfaces” on page 7)

96i I/O Audio Interface

• Supports sample rates up to 96 kHz

• 16 discrete channels of input, and 2 channels 
of output, with 4-segment LED meters on 
each channel. Audio inputs and outputs in-
clude:

• 16 channels of 24-bit, 96-kHz capable ana-
log input, with adjustable input sensitivity

• 2 channels of 24-bit, 96-kHz capable analog 
output, with selectable operating level

• 2 channels of 24-bit, 96 kHz-capable digital 
S/PDIF RCA input and output

• Loop Sync In and Out for connecting 
Pro Tools|HD interfaces and peripherals

• External Clock In and Out receive or send 1x 
Word clock
Optional Legacy I/O Audio Interfaces

For additional input and output channels, older 
Digidesign audio interfaces (or Legacy I/Os) can 
be connected to the 192 I/O, 192 Digital I/O, or 
96 I/O™ (the 96i I/O™ does not support Legacy 
interfaces). The following supported legacy in-
terfaces can only be used with 44.1 kHz or 
48 kHz sessions:

888|24 I/O Audio Interface

• Analog: 8 channels, XLR (balanced or unbal-
anced) connectors, selectable between +4 dBu 
or –10 dBV

• Digital: 8 channels, XLR (AES/EBU) connec-
tors; 2 channels, RCA (S/PDIF) connectors

882|20 I/O Audio Interface

• Analog: 8 channels, 1/4-inch TRS (balanced or 
unbalanced) connectors, selectable between 
+4 dBu and –10 dBV

• Digital: 2 channels, RCA (S/PDIF) connectors

1622 I/O Audio Interface

• Analog: 16 input channels and 2 output chan-
nels, 1/4-inch TRS (balanced or unbalanced) 
connectors. Inputs are selectable from +4 dBu 
to –10 dBV line levels and higher in 2 dB gain 
steps; outputs are selectable between +4 dBu 
or –10 dBV.

• Digital: 2 channels, RCA (S/PDIF) connectors.

Digidesign 24-bit ADAT Bridge I/O

• Optical: 16 channels, a pair of Lightpipe 
(ADAT) connectors.

• Analog output: 2 channels, 1/4-inch TRS (bal-
anced) connectors, selectable between +4 dBu 
and –10 dBV.

• Digital: 2 channels, XLR (AES/EBU); 2 chan-
nels RCA (S/PDIF) connectors.
Chapter 1: Welcome to Pro Tools|HD 7



8

System Requirements and 
Compatibility
Pro Tools|HD systems can be used with a 
Digidesign-qualified Windows or Mac computer 
running Pro Tools HD software. 

A DVD drive is required to use the Pro Tools In-
staller disc.

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved. 

For complete system requirements and a list of 
Digidesign-qualified computers, operating sys-
tems, hard drives, and third-party devices, refer 
to the latest information on the Digidesign web-
site:

www.digidesign.com/compatibility

MIDI Requirements

USB MIDI interfaces work effectively with 
Pro Tools systems on Windows or Mac. Serial 
MIDI interfaces are supported on Windows sys-
tems only.

For a list of supported adapters, refer to the 
Digidesign website (www.digidesign.com/
compatibility).

Only USB MIDI interfaces are compatible 
with Pro Tools systems on Mac OS X.
Modem-to-serial port adapters and serial 
MIDI devices are not supported.
Pro Tools|HD Setup Guide
Hard Drive Requirements

For optimal audio recording and playback, all 
Pro Tools|HD systems require one or more 
Digidesign-qualified drives.

If you are using one or more SCSI drives, refer to 
Appendix A, “Connecting SCSI Drives.”

If you are using an ATA/IDE or FireWire hard 
drive, initialize your drive with Windows Disk 
Management (Windows) or the Disk Utility ap-
plication included with Apple System software 
(Mac).

Avoid Recording to the System Drive

Recording to your system drive is not recom-
mended. Recording and playback on a system 
drive may result in lower track counts and fewer 
plug-ins.

Digidesign Registration
Review the enclosed Digidesign Registration In-
formation Card and follow the instructions on it 
to quickly register your purchase online. This is 
one of the most important steps you can take as 
a new user. Registering your purchase is the only 
way you can be eligible to receive:

• Complimentary technical support

• Future upgrade offers

• Limited warranty on hardware

For general hard drive maintenance and 
configuration information, see Appendix B, 
“Hard Drive Configuration and Mainte-
nance.”

For more information, see Appendix B, “Hard 
Drive Configuration and Maintenance.”



Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
the Pro Tools Guides.
Chapter 1: Welcome to Pro Tools|HD 9
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chapter 2

Installing Pro Tools on Windows
This chapter contains information for Windows 
systems only. If you are installing Pro Tools on a 
Mac computer, see Chapter 3, “Installing 
Pro Tools on Mac.”

Installation Overview
Installation of a Pro Tools|HD system on a Win-
dows computer includes the following steps:

1  “Installing Pro Tools Hardware” on page 11. 
This step includes:

• Disabling Driver Signing warnings.

• Installing and connecting Pro Tools|HD 
cards.

• Connecting audio interfaces

2  “Installing Pro Tools HD Software” on 
page 18.

3  “Launching Pro Tools” on page 20.

4  Configuring your system for improved perfor-
mance (see Chapter 4, “Configuring Your 
Pro Tools System”).

5  “Making Studio Connections” on page 63.

Before installing this version of Pro Tools, 
refer to the Read Me information included 
on the Pro Tools Installer disc.
Installing Pro Tools Hardware

Disabling Driver Signing Warnings
(Windows XP Only)

Before you install Pro Tools|HD cards, tempo-
rarily disable the Driver Signing warning option 
for Windows XP. This expedites and automates 
much of the installation process. If you do not 
temporarily disable this option, warning mes-
sages (that you are installing an unsigned driver) 
will appear for each DSP chip detected during 
software installation. 

To disable the warning option on Windows:

1  Right-click on My Computer and choose Proper-
ties.

2  Click the Hardware tab in the System Proper-
ties dialog.

3  Click the Driver Signing button.

4  Select “Ignore—Install the software anyway and 
don’t ask for my approval.”

5  Click OK to close the Driver Signing Options 
window.

6  Click OK to close the System Properties dialog.

7  Shut down the computer. 

8  Proceed to “Installing Pro Tools|HD Cards” on 
page 12.
Chapter 2: Installing Pro Tools on Windows 11
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Installing Pro Tools|HD Cards

This section shows how to install Pro Tools|HD 
cards into a Windows computer. 

To install Pro Tools cards:

1  Turn off your computer and any peripherals. 
Leave your computer’s power cable plugged in 
so the computer is grounded.

2  Disconnect all cables attached to the com-
puter (such as hard drives, displays, USB and 
FireWire devices) except for the power cable.

3  Open the computer case.

4  Remove the metal access port cover behind 
the slot you want to use by removing the screw 
and sliding the cover out from the access port. 

5  Do one of the following depending on 
whether your computer has PCIe or PCI card 
slots:

• Install the Accel Core (for PCIe) card in the 
first PCIe slot.

– or –

• Install the HD Core (for PCI) card in the 
first PCI slot.

To install cards into an expansion chassis, 
see the Expanded Systems Guide.

Before handling any card, discharge static 
electricity from your clothes or body by 
touching a grounded metal surface, such as 
the power supply case inside your computer.
Pro Tools|HD Setup Guide
6  If you are installing additional Pro Tools cards 
(or other cards), skip to the next step. If you 
have no additional cards to install, do the fol-
lowing:

• Secure the card in place with the slot access 
port screw you removed earlier.

• Close the computer case.

• Skip to “Connecting Audio Interfaces” on 
page 14. 

7  Do one of the following depending on 
whether your computer has PCIe or PCI card 
slots:

• Install the first HD Accel (for PCIe) card in 
the second PCIe slot.

– or –

• Install the first HD Accel card (if any) in the 
second PCI slot.

8  Install any remaining HD Accel cards in the re-
maining consecutive PCIe or PCI slots.

9  For a computer with PCI card slots, install any 
HD Process cards in the remaining consecutive 
PCI slots (64-bit or 32-bit). 

10  If you are installing a SCSI host bus adapter 
(HBA) card, install it in the highest-numbered 
remaining slot.

11  Check to be sure that your cards are installed 
in the proper order for your system, starting 
with the lowest numeric slot:

• Display card for your computer monitor

• Accel Core card (for PCIe) or HD Core card 
(for PCI) 

• HD Accel cards

• HD Process cards

• SCSI host bus adapter (HBA) card

12  Secure each card in place with the slot access 
port screws you removed earlier.



Connecting Pro Tools|HD Cards

In systems that include more than one card, you 
must connect all the Pro Tools|HD cards to each 
other with TDM FlexCables.

Each Pro Tools|HD card has two ports along the 
top of the card, labeled Port A and Port B. The 
FlexCable has two connectors, also labeled 
Port A and Port B, to ensure proper connection. 
Data communication across multiple cards is 
achieved by connecting Port B of the first card to 
Port A of the next card with a TDM FlexCable.

To connect Pro Tools|HD cards:

1  Shape the FlexCable before installing it on the 
card by holding the cable with its printed side 
facing you, and moving the Port B portion of 
the cable away from you and outwards, as 
shown below. Do not bend the cable more than 
you need to, as you may damage the traces in 
the cable. 

The first FlexCable always goes from Port B 
on the core card to Port A on the first 
expansion card, as described in the follow-
ing steps.

Preparing TDM FlexCable for installation
2  Slide the FlexCable into the notch of the core 
card, so that the Port B connector of the FlexCa-
ble can be aligned with Port B of the core card; 
and the Port A connector of the FlexCable can 
be aligned with Port A of the second card, as 
shown below.

3  Connect the Port A connector of the FlexCa-
ble to Port A on the second card. Push gently but 
firmly until the cable is fully connected to the 
card. Attach the other end of the FlexCable (la-
beled Port B) to Port B on the core card.

Inserting TDM FlexCable

Top view of two cards connected with TDM FlexCable

PORT B

PORT B

PORT A

PORT A

PORT B

PORT A

PORT A

PORT B

PORT B

PORT B

PORT A

PORT A

HD Core

HD Accel
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4  Verify the connection. Make sure the FlexCa-
ble ports seat flat against the sockets on the 
cards, and are firmly attached.

5  For systems with more than two cards, con-
nect each additional card to its preceding card. 
Use FlexCables to connect card pairs together, as 
described above, until all cards are connected. 
(Each HD Accel or HD Process card is packaged 
with a FlexCable.)

6  Close the computer case.

Connecting Audio Interfaces

Each Pro Tools|HD audio interface supplies up 
to 16 channels of input and output to your sys-
tem. Audio interfaces are connected directly to 
Pro Tools|HD cards, or through the Expansion 
ports on other Pro Tools|HD interfaces. 

Each Pro Tools|HD card supports up to 32 chan-
nels. To get a full 32 channels of I/O from one 
card, you can connect, or daisy-chain, a second 
16-channel Pro Tools|HD I/O to the first 
Pro Tools|HD I/O that is connected directly to 
the Pro Tools|HD card. 

Pro Tools|HD supports up to a maximum of ten 
192 I/Os, 192 Digital I/Os, or 96 I/Os. Up to five 
96i I/Os can be used simultaneously. 

Side view of two HD cards connected with TDM 
FlexCable

PORT B

PORT B

PORT A

PORT A

PORT B

PORT APORT A

PORT B
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For examples of connecting multiple I/Os, see 
Figure 1 and Figure 2 on page 15.

Legacy I/Os can also be connected to 
Pro Tools|HD interfaces (see “Connecting Leg-
acy I/Os” on page 16). 

To connect Pro Tools|HD audio interfaces:

1  If you are using a single 192 I/O, 
192 Digital I/O, 96 I/O, or 96i I/O, connect its 
Primary Port to the HD Core (for PCI) card with 
the DigiLink cable provided with the card. You 
must attach at least one 192 I/O, 
192 Digital I/O, 96 I/O, or 96i I/O to your sys-
tem in order for Pro Tools to launch.

2  Connect additional Pro Tools|HD audio inter-
faces to subsequent Digidesign audio cards, or 
daisy-chain the interfaces (by connecting the 
Primary Port of the secondary interface to the 
Expansion Port of the primary interface).

Pro Tools|HD audio interfaces need room at 
their sides to maintain proper air flow for 
cooling. Do not block the sides of the unit or 
disconnect the internal fan. If the units are 
rack-mounted in a case, remove the case 
lids or doors before operating the system. 
Failure to do so can result in the units over-
heating very quickly, which can perma-
nently damage sensitive components.

If you have at least one 192 I/O or 
192 Digital I/O in your system configura-
tion, it must be connected to the HD Core 
(for PCI) card as the primary interface.



Figure 1.  Two 96 I/Os (32-channel system)

12-foot DigiLink cable

18-inch DigiLink cable
Loop Sync cables

HD Core
Figure 2.  Three 96 I/Os (48-channel system)

12-foot DigiLink cable

18-inch DigiLink cable Loop Sync cables

12-foot DigiLink cable

Loop Sync cables

TDM FlexCable

HD Accel card 
or HD Process card

HD Core
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If you are connecting both 192 I/O (or 
192 Digital I/O) and 96 I/O audio interfaces to 
your system, connect the 192 I/O (or 
192 Digital I/O) to your HD Core (for PCI) card, 
followed by any additional 192 I/O (or 
192 Digital I/O) interfaces connected to subse-
quent cards. Then connect 96 I/O interfaces to 
subsequent cards, or to other interfaces, then 
connect 96i I/O interfaces.

You can also connect a single Pro Tools|HD in-
terface to each Pro Tools|HD card in your system 
using the provided DigiLink cables. (However, 
there is no advantage to this configuration over 
daisy-chaining interfaces.)

Connecting Loop Sync

If you are using two or more Pro Tools|HD audio 
interfaces or a SYNC peripheral, Loop Sync must 
be connected to maintain proper clock among 
the devices.

To make Loop Sync connections:

1  Connect the Loop Sync Out of each interface 
to the Loop Sync In of the next interface with 
the BNC cables included in your I/O packaging. 

2  Connect the Loop Sync Out of the last inter-
face to the Loop Sync In of the primary interface 
or SYNC peripheral.
Pro Tools|HD Setup Guide
Connecting Legacy I/Os

Each 192 I/O, 192 Digital I/O, and 96 I/O can 
support 16 channels of audio to and from 
Digidesign Legacy I/Os. (The 96i I/O does not 
support Legacy I/O.) Legacy I/Os include the 
888|24 I/O™, 882|20 I/O™, 1622 I/O™, and the 
24-bit ADAT Bridge I/O™. 

To connect Digidesign Legacy I/Os:

1  Connect the “MIX card” end of the peripheral 
cable that came with your Legacy I/O (60-pin 
side) to the Legacy Port on the primary 
Pro Tools|HD audio interface. Connect the 
other end to the Computer Port on the Legacy 
I/O. 

2  Do one of the following: 

• Connect any additional Legacy I/Os in the 
same manner, to Pro Tools|HD audio inter-
faces connected directly to HD cards.

– or –

• If you are using a Y cable (Legacy 16-chan-
nel peripheral cable adapter), connect this 
to the Legacy port first, then connect the 
audio interface peripheral cables to Port A 
and Port B of the Y cable.

The original 888 I/O and 882 I/O interfaces 
are not supported with Pro Tools|HD.

The 96i I/O does not support Legacy I/O.



3  To properly clock the Legacy I/O, connect the 
Ext. Clock output port on the Pro Tools|HD I/O 
to the Slave Clock IN on the Legacy I/O. The 
Legacy I/O will switch to Slave mode once the 
proper clock is outputting from the 
Pro Tools|HD I/O. Always use the Ext. Clock Out 
port of the same I/O to which the Legacy I/O is 
attached.

If you are using the Y cable to connect multiple 
MIX™ audio interfaces, you must also connect 
the Slave Clock Out of the first Legacy interface 
to the Slave Clock In of the second Legacy inter-
face with the provided BNC cable. You cannot 
clock more than two MIX audio interfaces from 
a single Pro Tools|HD audio interface. If you 
have a third MIX audio interface, supply its 

Optional 16-channel peripheral cable adapter

“A” to first
Legacy I/O

“B” to second
Legacy I/O

To Legacy Port on
Pro Tools|HD audio interface
256x clock from the Pro Tools|HD I/O to which 
its 60-pin cable is attached (either your second 
audio interface, or directly to an HD Accel or 
HD Process card).

To ensure the proper functioning of Legacy 
I/Os (such as an 888|24 I/O or 
882|20 I/O), launch Pro Tools and initial-
ize the Legacy I/Os in the Hardware Setup 
dialog before turning them on (See “Config-
uring Legacy I/Os” on page 54). Then quit 
Pro Tools and shut down your computer. 
When relaunching your Pro Tools system, 
turn on your Legacy I/Os first and allow 
them to finish booting before turning on 
your Pro Tools|HD audio interfaces, and 
then your computer.

Before you turn on and configure your Leg-
acy I/Os, turn down the volume of output 
devices. Very loud digital noise may be 
emitted before the Legacy I/O is initialized.
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Installing Pro Tools HD 
Software
After your Pro Tools|HD hardware is installed 
and connected, you are ready to install 
Pro Tools software.

To install Pro Tools HD software:

1  Start Windows, logging in with Administrator 
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2  Wait for the Found New Hardware Wizard di-
alog to appear and leave it open: Do not click 
Next.

3  Insert the Pro Tools Installer disc in your DVD 
drive. 

4  On the Installer disc, locate and double-click 
the Setup.exe file.

5  Follow the on-screen instructions to proceed 
with installation and click Next when prompted.

6  Follow the on-screen instructions to proceed 
with installation and click Next when prompted.

7  To install the complete compliment of 
Pro Tools software and plug-ins, leave Pro Tools 
selected. 

Make sure you have disabled Driver Signing 
warnings before beginning software instal-
lation. This will reduce the number of 
warning messages you see during installa-
tion. See “Disabling Driver Signing Warn-
ings” on page 11.
Pro Tools|HD Setup Guide
8  At the Select Features page, do one of the fol-
lowing:

• To install all Pro Tools application files and 
free plug-in suites (and associated content), 
leave the default Installation options se-
lected and click Continue.

– or –

• Select (or deselect) a custom configuration 
of Installation options (see “Installation 
Options” on page 19) and click Continue.

9  Click Next.

10  Select your work environment. This loads an 
initial set of Pro Tools Preferences that include 
some of the more popular settings for post pro-
duction, audio, or audio with MIDI. 

11  Click Next.

12  Click Install.

13  Wait for the installer to finish installing all 
software components, drivers, and PACE System 
files before proceeding to the next step. 

14  When installation is complete, click Finish.

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Refer-
ence Guide for more information.

Several messages are displayed during in-
stallation that can be ignored, including 
multiple “Found New Hardware” dialogs 
and “A Problem Occurred During Hardware 
Installation.”

Additionally, if you get a warning dialog 
about the driver not passing Windows Logo 
testing, click Continue Anyway.



Installation Options

Pro Tools HD Options

To install a subset of Pro Tools software and 
plug-ins (and associated content), click the plus 
(+) next to Pro Tools HD 8.0 option in the Select 
Features page of the installer, and deselect any 
of the following options that you do not want 
installed.

Application Files (Required for Pro Tools) In-
stalls the Pro Tools application and supporting 
library files needed to run Pro Tools. This option 
must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including 
DigiRack plug-ins, free Bomb Factory plug-ins, 
Eleven Free, TL Utilities, and Digidesign D-Fi 
and Maxim plug-ins.

Pro Tools Creative Collection Installs a set of free 
RTAS effects plug-ins and virtual instrument 
plug-ins (including 4.4 GB of associated sample 
content). For more information, see the Creative 
Collection Plug-ins Guide.

Pro Tools Utilities Installs Calibration Mode 
Templates for Pro Tools|HD systems, DigiTest™, 
and firmware updaters for SYNC I/O™ and 
SYNC HD™.

Additional Options

The Pro Tools installer provides the following 
additional options to install along with 
Pro Tools software and plug-ins.

Mac HFS+ Disk Support Option This option lets 
your Pro Tools system read, write, record, and 
play back using Mac-formatted HFS+ disks. HFS+ 
disks are commonly referred to as Mac OS Ex-
tended disks.
Avid Video Engine The Avid Video Engine is re-
quired to use Pro Tools with Avid video periph-
erals such as the Avid Mojo® or the Digidesign 
AVoption|V10. 

Command|8 Controller and Driver The Com-
mand|8® Driver is required if you are using the 
Digidesign Command|8 control surface.

Installing QuickTime

QuickTime is required for Pro Tools if you plan 
to include movie files, or import MP3 or MP4 
(AAC) files in your sessions. QuickTime for Win-
dows is available as a free download from the 
Apple website.

To install QuickTime:

1  Visit www.apple.com and download the 
QuickTime for Windows installer application to 
your computer.

2  Double-click the QuickTime installer applica-
tion and follow the on-screen installation in-
structions.

3  Restart your computer.

For information on which version of Quick-
Time is compatible with your version of 
Pro Tools, visit the compatibility pages of 
the Digidesign website:

www.digidesign.com/compatibility

 If you turned off Driver Signing Warning on 
your computer, be sure to enable it once 
Pro Tools hardware and software have been 
installed. 
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Launching Pro Tools
To use Pro Tools HD, you must always have an 
inserted iLok with an authorization for 
Pro Tools HD. One pre-authorized iLok is in-
cluded with your Pro Tools HD system.

To launch Pro Tools HD software:

1  Make sure HD hardware is connected to your 
computer.

2  Insert the pre-authorized iLok into an avail-
able USB port on your computer.

3  Do one of the following:

• Double-click the Pro Tools HD shortcut on 
the desktop.

– or –

• Locate and double-click the Pro Tools HD 
application on your hard drive.

4  Use the Quick Start dialog to do one of the fol-
lowing:

• Create a new session from a template.

• Create a new blank session. 

• Open a session.

Do not remove the iLok during Pro Tools 
launch or use.
Pro Tools|HD Setup Guide
Additional Software on the 
Pro Tools Installer Disc
The Pro Tools HD Installer disc provides addi-
tional software for your system, including the 
HD Pack collection of plug-ins, third-party ap-
plications and plug-ins, audio drivers (for play-
ing other audio applications through your 
Digidesign hardware) and a Pro Tools demo ses-
sion.

Quick Start dialog

For more information on the Quick Start di-
alog and session templates, see the 
Pro Tools Reference Guide.

Refer to your Pro Tools Installer disc for ad-
ditional software and installers.



HD Pack Plug-ins

Your Pro Tools package includes the HD Pack 
collection of plug-ins from Digidesign and 
Digidesign Development Partners. Once you've 
completed your Pro Tools installation, you can 
install the contents of HD Pack.

HD Pack installers are located on the Pro Tools 
Installer disc in the Additional Files\
HD Pack Installers folder.

Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. 

Installers are located on your Pro Tools Installer 
disc in the Additional Files\3rd Party Content 
folder.

Windows Audio Drivers

The Digidesign ASIO Driver and WaveDriver 
Windows System Audio Driver let you use your 
Digidesign hardware interface with third-party 
applications that support the ASIO Driver or 
WaveDriver MME (Multimedia Extension).

The Digidesign ASIO Driver and WaveDriver for 
your Digidesign hardware are automatically in-
stalled when you install Pro Tools.
Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Out-
put) Driver is a single-client multichannel 
sound driver that allows third-party audio pro-
grams that support the ASIO standard to record 
and play back through Digidesign hardware.

Digidesign WaveDriver

(Windows XP Only)

The Digidesign WaveDriver Windows System 
Audio Driver is a single-client, stereo sound 
driver that allows third-party audio programs 
that support the WaveDriver MME (Multimedia 
Extension) standard to play back through 
Digidesign hardware.

Standalone Windows Audio Drivers

Digidesign Windows Audio Drivers can be in-
stalled on Windows systems that do not have 
Pro Tools software installed. Use the standalone 
version of the Digidesign Windows Audio Driv-
ers installer (Digidesign Audio Drivers 
Setup.exe), which is available on the Pro Tools 
Installer disc.

For detailed information on configuring the 
Digidesign ASIO Driver, see the Windows 
Audio Drivers Guide.

For detailed information on configuring the 
Digidesign WaveDriver, see the Windows 
Audio Drivers Guide.

For information on installing and configur-
ing the standalone version of the Digidesign 
Windows Audio Drivers, see the Windows 
Audio Drivers Guide.
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Pro Tools Demo Session

The Pro Tools HD Installer disc includes a demo 
session that you can use to verify that your sys-
tem is working. The demo session for 
Pro Tool HD is named Meant To Be.

To install the demo session:

1  Insert the Pro Tools HD Installer disc into your 
DVD drive.

2  On the installer disc, in the Additional Files 
folder, locate and open the Pro Tools Demo Ses-
sion Installer folder.

3  Double-click the HD Demo Session Setup.exe 
file.

4  Follow the onscreen instructions to proceed 
with installation.

5  When prompted, select your audio drive as 
the install location and click Next to begin the 
install.

6  When installation is complete, click Finish.

The demo session can be opened by double-
clicking the Meant To Be.ptf file found in the 
Pro Tools Demo Session folder.

Before installing the demo session to your 
audio drive, make sure your audio drive is 
configured as described in “Formatting an 
Audio Drive” on page 76.
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Uninstalling Pro Tools
If you need to uninstall Pro Tools software from 
your computer, use the Uninstaller application. 

To remove Pro Tools from your computer:

1  Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed. 

2  Go to C:\Program Files\Digidesign\ 
Pro Tools\Pro Tools Utilities and double-click 
Uninstall Pro Tools Setup.exe.

3  Click Next to proceed with the uninstall.

4  Click Uninstall.

5  Enter your Administrator password and click 
OK. 

6  Click Finish to restart your computer and com-
plete the uninstallation.



chapter 3

Installing Pro Tools on Mac
This chapter contains information for Mac sys-
tems only. If you are installing Pro Tools on a 
Windows computer, see Chapter 2, “Installing 
Pro Tools on Windows.”

Installation Overview
Installation of a Pro Tools|HD system on a Mac 
includes the following steps:

1  “Installing Pro Tools Hardware” on page 23. 
This step includes:

• Installing and connecting Pro Tools|HD 
cards.

• Connecting audio interfaces

2  “Installing Pro Tools HD Software” on 
page 32.

3  “Launching Pro Tools” on page 33.

4  Configuring your system for improved perfor-
mance (see Chapter 4, “Configuring Your 
Pro Tools System”).

5  “Making Studio Connections” on page 63.

Before installing this version of Pro Tools, 
refer to the Read Me information included 
on the Pro Tools Installer disc.
Installing Pro Tools Hardware
To install Pro Tools|HD hardware, you first in-
stall Pro Tools|HD cards, then for systems with 
more than one card, connect the cards with a 
TDM FlexCable.

Installing Pro Tools|HD Cards

This section shows how to install Pro Tools|HD 
cards into Mac computers. The installation pro-
cedure varies depending on the type of Mac you 
have.

If you are installing cards in a Mac Pro, see “In-
stalling Pro Tools|HD Cards in a Mac Pro” on 
page 24. 

If you are installing cards in a Power Mac, see 
“Installing Pro Tools|HD Cards in a Power Mac 
G5” on page 26.

To install cards into an expansion chassis, 
see the Expanded Systems Guide.
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Installing Pro Tools|HD Cards in a Mac 
Pro

The PCI Express-equipped Mac Pro has three PCI 
Express (PCIe) slots (named slots 2, 3, and 4). 
The PCI Express slot numbers increase from bot-
tom to top as you face the open computer case 
from the side. Install the Accel Core (for PCIe) 
card into PCI slot 2. 

To install Pro Tools cards in a Mac Pro:

1  Turn off your computer and any peripherals. 
Leave your computer’s power cable plugged in 
so the computer is grounded.

2  Disconnect all cables attached to the com-
puter (such as hard drives, displays, USB and 
FireWire devices) except for the power cable.

3  Lay the computer on its side so the access 
panel is facing up

4  Open the computer case using the latch lo-
cated on the back of the computer.

Figure 3.  Mac Pro

Follow these instructions carefully to avoid 
damaging the card and its components.

PCIe slot 1
(video card)

PCIe slot 2

PCIe slot 3

PCIe slot 4
(hidden)

SATA drive trays and drives
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5  Remove the clamp that holds secures the 
metal access port covers to the chassis.

6  Remove the metal access port covers for the 
slots you want to use.

7  Remove your computer’s SATA drive trays. If 
any extra SATA drives are installed, remove 
them also. Refer to your computer’s documenta-
tion for information on removing SATA drives 
and SATA drive trays.

8  Install the Accel Core (for PCIe) card into the 
lowest-numbered slot in the computer (slot 2). 
This will be the slot closest to the graphics card, 
as shown in Figure 3 on page 24. Do the follow-
ing:

• Hold the card above slot 2 at a slight angle 
so that the front of the card is higher than 
the back of the card (where the card’s Dig-
iLink connector is located), as in Figure 4.

• With the card at an angle, rest the card’s 
back bracket against the edge of the chassis, 
where the computer’s slot access port is lo-
cated.

Before handling any card, discharge static 
electricity from your clothes or body by 
touching a grounded metal surface, such as 
the power supply case inside your computer 
with the power cable connected.

Figure 4.  Holding the card above the slot at an angle



• Carefully slide the front of the card down 
into slot 2’s grey plastic PCIe card support 
(where the slot numbers appear), as in 
Figure 5.

• With the card’s PCIe connectors facing 
down, carefully slide the card straight 
down and firmly seat the card’s PCIe con-
nector into the slot 2’s PCIe slot, making 
sure that all card components on the front 
of the card have clearance from the grey 
plastic PCI card support, as in Figure 6.

Figure 5.  Sliding the front of the card into PCIe card 
support

Figure 6.  Figure 3. PCIe connectors facing down
9  Install the first expansion card (if any) in the 
second slot (slot 3).

10  Install the second expansion card (if any) in 
slot 4.

11  If you are installing a SCSI host bus adapter 
(HBA) card, install it in the highest-numbered 
remaining slot.

12  Check to be sure that your cards are installed 
in the proper order for your system, starting 
with the lowest numeric slot:

• Display card for your computer monitor

• Accel Core (for PCIe) card

• HD Accel (for PCIe) cards

• Digidesign-approved video capture card

• SCSI host bus adapter (HBA) card

13  Replace the SATA drives.

14  Reattach the clamp that secures the cards 
and the slot covers to the chassis. 

Do not force the card into the PCI card sup-
port slot. When you have the correct instal-
lation angle, the card should slide in easily. 
If you do not have the correct angle, reposi-
tion the card.

The card’s PCIe connectors will not seat 
completely until you have replaced the 
clamp that secures the cards and the metal 
access port covers to the chassis.
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Installing Pro Tools|HD Cards in a Power 
Mac G5

Follow these instructions to install Pro Tools|HD 
cards in PCI or PCI Express equipped Power Mac 
G5 computers.

To install Pro Tools cards in a Power Mac G5:

1  Turn off your computer and any peripherals. 
Leave your computer’s power cable plugged in 
so the computer is grounded.

2  Disconnect all cables attached to the com-
puter (such as hard drives, displays, USB and 
FireWire devices) except for the power cable.

3  Lay the computer on its side so the access 
panel is facing up

4  Open the computer case using the latch lo-
cated on the rear of the computer.

5  Remove the metal access port cover behind 
the slot you want to use by removing the screw 
and sliding the cover out from the access port. 

6  Install the Accel Core (for PCIe) or HD Core 
(for PCI) card into the lowest-numbered slot in 
the computer. This will be the slot closest to the 
graphics card, as shown in the following exam-
ples:

Power Mac G5 (PCI Express) The PCI Express-
equipped Power Mac G5 has three PCI Express 
(PCIe) slots (named slots 2, 3, and 4). The PCI 
Express slot numbers increase from bottom to top 
as you face the open computer case from the 
side. Install the Accel Core (for PCIe) card into 
PCI slot 2. 

Before handling any card, discharge static 
electricity from your clothes or body by 
touching a grounded metal surface, such as 
the power supply case inside your computer.
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Power Mac G5 (PCI) The PCI-equipped Power 
Mac G5 has three PCI slots (named PCI slot 2, 3, 
and 4). Slot numbers increase from bottom to top 
as you face the open computer case from the 
side. Install the HD Core (for PCI) card into PCI 
slot 2. 

7  Install the first expansion card (if any) in the 
second slot (slot 3).

8  If you are installing a SCSI host bus adapter 
(HBA) card, install it in the highest-numbered 
remaining slot.

Power Mac G5 (PCI Express equipped)

Power Mac G5 (PCI equipped)

PCIe slot 1
(video card)

PCIe slot 2

PCIe slot 3

PCIe slot 4

PCIe slot 1
(video card)

PCI slot 2

PCI slot 3

PCI slot 4



9  Check to be sure that your cards are installed 
in the proper order for your system, starting 
with the lowest numeric slot:

• Pro Tools|HD (for PCIe) Systems

• Display card for your computer monitor

• Accel Core (for PCIe) card

• HD Accel (for PCIe) cards

• Digidesign-approved video capture card

• SCSI host bus adapter (HBA) card

• Pro Tools|HD (for PCI) Systems

• Display card for your computer monitor

• HD Core (for PCI) card

• HD Accel (for PCI) cards

• HD Process (for PCI) cards

• Digidesign-approved video capture card

• SCSI host bus adapter (HBA) card

10  Secure each card in place with the slot access 
port screws you removed earlier. 

Connecting Pro Tools|HD Cards

In systems that include more than one card, you 
must connect all the Pro Tools|HD cards to each 
other with TDM FlexCables.

Each Pro Tools|HD card has two ports along the 
top of the card, labeled Port A and Port B. The 
FlexCable has two connectors, also labeled 
Port A and Port B, to ensure proper connection. 
Data communication across multiple cards is 
achieved by connecting Port B of the first card to 
Port A of the next card with a TDM FlexCable. 

The first FlexCable always goes from Port B 
on the core card to Port A on the first 
expansion card, as described in the follow-
ing steps.
The slot numbering in your computer deter-
mines whether you will be working right-to-left 
or left-to-right when connecting cards. Refer to 
the instructions below for your model of com-
puter. 

To connect Pro Tools|HD cards:

1  Shape the FlexCable before installing it on the 
card by holding the cable with its printed side 
facing you, and moving the Port B portion of 
the cable away from you and outwards, as 
shown below. Do not bend the cable more than 
you need to, as you may damage the traces in 
the cable. 

2  Slide the FlexCable into the notch of the core 
card, so that the Port B connector of the FlexCa-
ble can be aligned with Port B of the core card; 
and the Port A connector of the FlexCable can 
be aligned with Port A of the second card, as 
shown below.

Preparing TDM FlexCable for installation

Inserting TDM FlexCable

PORT B

PORT B

PORT A

PORT A

PORT B

PORT A

PORT A

PORT B
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3  Connect the Port A connector of the FlexCa-
ble to Port A on the second card. Push gently but 
firmly until the cable is fully connected to the 
card. Attach the other end of the FlexCable (la-
beled Port B) to Port B on the core card.

4  Verify the connection. Make sure the FlexCa-
ble ports seat flat against the sockets on the 
cards, and are firmly attached.

5  For systems with more than two cards, con-
nect each additional card to its preceding card. 
Use FlexCables to connect card pairs together, as 
described above, until all cards are connected. 
(Each HD Accel or HD Process card is packaged 
with a FlexCable.)

6  Close the computer case.

Top view of two cards connected with TDM FlexCable

Side view of two HD cards connected with TDM 
FlexCable

PORT B

PORT B

PORT A

PORT A

HD Core

HD Accel

PORT B

PORT B

PORT A

PORT A

PORT B

PORT APORT A

PORT B
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Connecting Audio Interfaces

Each Pro Tools|HD audio interface (except the 
96i I/O) supplies up to 16 channels of input and 
output to your system. Audio interfaces are con-
nected directly to Pro Tools|HD cards, or 
through the Expansion ports on other 
Pro Tools|HD interfaces. 

Each Pro Tools|HD card supports up to 32 chan-
nels. To get a full 32 channels of I/O from one 
card, you can connect, or daisy-chain, a second 
16-channel Pro Tools|HD I/O to the first 16-
channel Pro Tools|HD I/O that is connected di-
rectly to the Pro Tools|HD card. 

Pro Tools|HD supports up to a maximum of ten 
192 I/Os, 192 Digital I/Os, or 96 I/Os. Up to five 
96i I/Os can be used simultaneously. 

For examples of connecting multiple I/Os, see 
Figure 7 and Figure 8 on page 29.

Legacy I/Os can also be connected to 
Pro Tools|HD interfaces (see “Connecting Leg-
acy I/Os” on page 30.) 

Pro Tools|HD audio interfaces need room at 
their sides to maintain proper air flow for 
cooling. Do not block the sides of the unit or 
disconnect the internal fan. If the units are 
rack-mounted in a case, remove the case 
lids or doors before operating the system. 
Failure to do so can result in the units over-
heating very quickly, which can perma-
nently damage sensitive components.



Figure 7.  Two 96 I/Os (32-channel system)

HD Core or

12-foot DigiLink cable

18-inch DigiLink cable
Loop Sync cables

Accel Core card
Figure 8.  Three 96 I/Os (48-channel system)

HD Accel card 

12-foot DigiLink cable

18-inch DigiLink cable Loop Sync cables

12-foot DigiLink cable

Loop Sync cables

TDM FlexCable

or HD Process card

HD Core or
Accel Core card
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To connect Pro Tools|HD audio interfaces:

1  If you are using a single 192 I/O, 
192 Digital I/O, 96 I/O, or 96i I/O, connect its 
Primary Port to the Accel Core (for PCIe) or HD 
Core (For PCI) card with the DigiLink cable pro-
vided with the card. You must attach at least one 
192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O to 
your system in order for Pro Tools to launch.

2  Connect additional Pro Tools|HD audio inter-
faces to subsequent Digidesign audio cards, or 
daisy-chain the interfaces (by connecting the 
Primary Port of the secondary interface to the 
Expansion Port of the primary interface).

If you are connecting both 192 I/O (or 
192 Digital I/O) and 96 I/O audio interfaces to 
your system, connect the 192 I/O (or 
192 Digital I/O) to your Accel Core (for PCIe) or 
HD Core (for PCI) card, followed by any addi-
tional 192 I/O (or 192 Digital I/O) interfaces 
connected to subsequent cards. Then connect 
96 I/O interfaces to subsequent cards, or to 
other interfaces, then connect 96i I/O inter-
faces.

You can also connect a single Pro Tools|HD in-
terface to each Pro Tools|HD card in your system 
using the provided DigiLink cables. (However, 
there is no advantage to this configuration over 
daisy-chaining interfaces.)

If you have at least one 192 I/O or 
192 Digital I/O in your system configura-
tion, it must be connected to the Accel Core 
(for PCIe) or HD Core (for PCI) card as the 
primary interface.
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Connecting Loop Sync

If you are using two or more Pro Tools|HD audio 
interfaces or a SYNC peripheral, Loop Sync must 
be connected to maintain proper clock among 
the devices.

To make Loop Sync connections:

1  Connect the Loop Sync Out of each interface 
to the Loop Sync In of the next interface with 
the BNC cables included in your I/O packaging. 

2  Connect the Loop Sync Out of the last inter-
face to the Loop Sync In of the primary interface 
or SYNC peripheral.

Connecting Legacy I/Os

Each 192 I/O, 192 Digital I/O, and 96 I/O can 
support 16 channels of audio to and from 
Digidesign Legacy I/Os. (The 96i I/O does not 
support Legacy I/O.) Legacy I/Os include the 
888|24 I/O, 882|20 I/O, 1622 I/O, and the 24-bit 
ADAT Bridge I/O™ 

The 96i I/O does not support Legacy I/O.

The original 888 I/O and 882 I/O interfaces 
are not supported with Pro Tools|HD.



To connect Digidesign Legacy I/Os:

1  Connect the “MIX card” end of the peripheral 
cable that came with your Legacy I/O (60-pin 
side) to the Legacy Port on the primary 
Pro Tools|HD audio interface. Connect the other 
end to the Computer Port on the Legacy I/O. 

2  Do one of the following:

• Connect any additional Legacy I/Os in the 
same manner, to Pro Tools|HD audio inter-
faces connected directly to Pro Tools|HD 
cards.

– or –

• If you are using a Y cable (Legacy 16-chan-
nel peripheral cable adapter), connect this 
to the Legacy port first, then connect the 
audio interface peripheral cables to Port A 
and Port B of the Y cable.

3  To properly clock the Legacy I/O, connect the 
Ext. Clock output port on the Pro Tools|HD I/O 
to the Slave Clock IN on the Legacy I/O. The 
Legacy I/O will switch to Slave mode once the 
proper clock is outputting from the 
Pro Tools|HD I/O. Always use the Ext. Clock Out 
port of the same I/O to which the Legacy I/O is 
attached.

Optional 16-channel peripheral cable adapter

“A” to first
Legacy I/O

“B” to second
Legacy I/O

To Legacy Port on
Pro Tools|HD audio interface
If you are using the Y cable to connect multiple 
MIX audio interfaces, you must also connect the 
Slave Clock Out of the first Legacy interface to 
the Slave Clock In of the second Legacy inter-
face with the provided BNC cable. You cannot 
clock more than two MIX audio interfaces from 
a single Pro Tools|HD audio interface. 

If you have a third MIX audio interface, supply 
its 256x clock from the Pro Tools|HD I/O to 
which its 60-pin cable is attached (either your 
second audio interface, or directly to an 
HD Accel or HD Process card).

To ensure the proper functioning of Legacy 
I/Os (such as an 888|24 I/O or 
882|20 I/O), launch Pro Tools and initial-
ize the Legacy I/Os in the Hardware Setup 
dialog before turning them on (See “Config-
uring Legacy I/Os” on page 54). Then quit 
Pro Tools and shut down your computer. 
When relaunching your Pro Tools system, 
turn on your Legacy I/Os first and allow 
them to complete booting before turning on 
your Pro Tools|HD audio interfaces, and 
then your computer.

Before you turn on and configure your Leg-
acy I/Os, turn down the volume of output 
devices. Very loud digital noise may be 
emitted before the Legacy I/O is initialized.
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Installing Pro Tools HD 
Software
After your Pro Tools|HD hardware is installed 
and connected, you are ready to install 
Pro Tools software.

To install Pro Tools HD software:

1  Make sure you are logged in as an Administra-
tor for the account where you want to install 
Pro Tools. For details on Administrator privi-
leges in Mac OS X, refer to your Apple OS X doc-
umentation. 

2  Insert the Pro Tools Installer disc in your DVD 
drive. 

3  On the Installer disc, locate and double-click 
the Install Pro Tools HD.mpkg file.

4  Follow the on-screen instructions to proceed 
with installation.

5  Click Continue each time you are prompted.

6  At the Installation Type page, do one of the 
following:

• To install all Pro Tools application files and 
free plug-in suites (and associated content), 
leave the default Installation options se-
lected and click Continue.

– or –

• Select (or deselect) a custom configuration 
of Installation options (see “Installation 
Options” on page 32) and click Continue.

7  Click Install.

8  If prompted, enter your Administrator pass-
word and click OK to accept the installation.

Do not install or operate Pro Tools while 
logged in as a root-level user. File permis-
sions of a root-level user make it possible to 
perform actions that may conflict with 
Pro Tools file management tasks.
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9  Select your work environment. This loads an 
initial set of Pro Tools Preferences that include 
some of the more popular settings for post pro-
duction, audio, or audio with MIDI. 

10  Click Continue.

11  When installation is complete, click Restart.

Installation Options

Pro Tools HD Options

To install a subset of Pro Tools software and 
plug-ins (and associated content), click the re-
veal triangle for the Pro Tools HD 8.0 option in 
the installer, and deselect any of the following 
options that you do not want installed.

Application Files (Required for Pro Tools) In-
stalls the Pro Tools application and supporting 
library files needed to run Pro Tools. This option 
also installs the Digidesign CoreAudio Driver. 
This option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including 
DigiRack plug-ins, free Bomb Factory plug-ins, 
Eleven Free, TL Utilities, and Digidesign D-Fi 
and Maxim plug-ins.

Pro Tools Creative Collection Installs a set of free 
RTAS effects plug-ins and virtual instrument 
plug-ins (including 4.4 GB of associated sample 
content). For more information, see the Creative 
Collection Plug-ins Guide.

Pro Tools Utilities Installs Calibration Mode 
Templates for Pro Tools|HD systems, DigiTest, 
and firmware updaters for SYNC I/O and 
SYNC HD.

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Refer-
ence Guide for more information.



Additional Options

The Pro Tools installer provides the following 
additional options to install along with 
Pro Tools software and plug-ins.

DigiDesign CoreAudio Driver This option installs 
the Digidesign CoreAudio Driver, which lets 
you use Digidesign-qualified audio interfaces 
with third-party applications that support the 
CoreAudio Driver standard.

Avid Video Engine The Avid Video Engine is re-
quired to use Pro Tools with Avid video periph-
erals such as the Avid Mojo or the Digidesign 
AVoption|V10. 

MIDI I/O Driver The MIDI I/O Driver is required 
if you are using the Digidesign MIDI I/O™ inter-
face. 

Launching Pro Tools
To use Pro Tools HD, you must always have an 
inserted iLok with an authorization for 
Pro Tools HD. One pre-authorized iLok is in-
cluded with your Pro Tools HD system.

To launch Pro Tools HD software:

1  Make sure HD hardware is connected to your 
computer system.

2  Insert the pre-authorized iLok into an avail-
able USB port on your computer.

Do not remove the iLok during Pro Tools 
launch or use.
3  Do one of the following:

• Click the Pro Tools HD icon in the Dock. 

– or –

• Locate and double-click the Pro Tools HD 
application on your hard drive.

4  Use the Quick Start dialog to do one of the fol-
lowing:

• Create a new session from a template.

• Create a new blank session. 

• Open a session.

Quick Start dialog

For more information on the Quick Start di-
alog and session templates, see the 
Pro Tools Reference Guide.
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Additional Software on the 
Pro Tools Installer Disc
The Pro Tools HD Installer disc provides addi-
tional software for your system, including the 
HD Pack collection of plug-ins, third-party ap-
plications and plug-ins, audio drivers (for play-
ing other audio applications through your 
Digidesign hardware) and a Pro Tools demo ses-
sion.

HD Pack Plug-ins

Your Pro Tools package includes the HD Pack 
collection of plug-ins from Digidesign and 
Digidesign Development Partners. Once you've 
completed your Pro Tools installation, you can 
install the contents of HD Pack.

HD Pack installers are located on the Pro Tools 
Installer disc in the Additional Files\
HD Pack Installers folder.

Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. 

Installers are located on your Pro Tools Installer 
disc in the Additional Files\3rd Party Content 
folder.

Refer to your Pro Tools Installer disc for ad-
ditional software and installers.
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Digidesign CoreAudio Driver

The Digidesign CoreAudio Driver is a multi-cli-
ent, multichannel sound driver that allows 
CoreAudio-compatible applications to record 
and play back through Digidesign hardware.

The CoreAudio Driver is installed by default 
when you install Pro Tools. 

Standalone CoreAudio Driver

The Digidesign CoreAudio Driver can be in-
stalled as a standalone driver on Mac systems 
that do not have Pro Tools software installed.

For information on configuring the Digide-
sign CoreAudio Driver, see the Digidesign 
CoreAudio Guide.

For information on installing and configur-
ing the standalone version of the Digidesign 
CoreAudio Driver, see the CoreAudio Driv-
ers Guide.

If you uninstall Pro Tools, CoreAudio 
Driver is automatically uninstalled at that 
time.



Pro Tools Demo Session

The Pro Tools HD Installer disc includes a demo 
session that you can use to verify that your sys-
tem is working. The demo session for 
Pro Tool HD is named Meant To Be.

To install the demo session:

1  Insert the Pro Tools HD Installer disc into your 
DVD drive.

2  On the installer disc, in the Additional Files 
folder, locate and open the Pro Tools Demo Ses-
sion Installer folder.

3  Double-click the HD Demo Session Setup.pkg 
file.

4  Follow the on-screen instructions to proceed 
with installation.

5  When prompted, select your audio drive as 
the install location and click Continue to begin 
the install.

6  Click Install.

7  When installation is complete, click Close.

The demo session can be opened by double-
clicking the Meant To Be.ptf file found in the 
Pro Tools Demo Session folder.

Before installing the demo session to your 
audio drive, make sure the drive is config-
ured as described in “Formatting an Audio 
Drive” on page 76.
Uninstalling Pro Tools
If you need to uninstall Pro Tools software from 
your computer, use the Uninstaller application. 

To remove Pro Tools from your computer:

1  Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed. 

2  Go to Applications/Digidesign/Pro Tools/
Pro Tools Utilities and double-click the 
“Uninstall Pro Tools” file.

3  Click Continue to proceed with the uninstall.

4  Choose the type of uninstall you want to per-
form:

Safe Uninstall Leaves certain plug-ins and sys-
tem files needed for compatibility with some 
Avid products.

Clean Uninstall Removes all Pro Tools files, in-
cluding system files, Digidesign plug-ins, and 
MIDI patch names. 

5  Click Uninstall. 

6  Enter your Administrator password and click 
OK. 

7  Click Finish to close the Installer window.
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chapter 4

Configuring Your Pro Tools System
After you have connected your system and in-
stalled Pro Tools software, you are ready to start 
up and configure your Pro Tools system.

Starting Up or Shutting Down 
Your System
Whenever you start your system, turn on all of 
your system components in a specific order.

Start up your Pro Tools system in this order:

1  Make sure all your equipment (including your 
computer) is off.

2  Lower the volume of all output devices in your 
system. 

3  For Pro Tools|HD systems with an expansion 
chassis, turn on the expansion chassis.

4  Turn on any external hard drives. Wait ap-
proximately ten seconds for them to spin up to 
speed.

5  Turn on any control surfaces (such as Com-
mand|8) or worksurfaces (such as D-Command).

6  Turn on any MIDI interfaces and devices, or 
synchronization peripherals.
7  With the volume of all output devices low-
ered, turn on any Pro Tools Legacy I/Os (such as 
an 888|24 I/O or 882|20 I/O). Wait at least fif-
teen seconds for the audio interface to initialize 
and the status LEDs to stop flashing.

8  With the volume of all output devices low-
ered, turn on your Pro Tools|HD audio inter-
faces. Wait at least fifteen seconds for the audio 
interface to initialize and the status LEDs to stop 
flashing.

9  Turn on your computer. 

10  Launch Pro Tools or any third-party audio or 
MIDI applications. 

Shut down your Pro Tools system in this order:

1  Quit Pro Tools and any other running applica-
tions. 

2  Turn off or lower the volume of all output de-
vices in your system. 

3  Turn off your computer.

4  Turn off your Pro Tools audio interfaces.

5  For Pro Tools|HD systems with an expansion 
chassis, turn off the chassis.

6  Turn off any MIDI interfaces, MIDI devices, or 
synchronization peripherals.

To quit Pro Tools, choose File > Exit (Win-
dows) or Pro Tools > Quit (Mac).
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7  Turn off any control surfaces or worksurfaces.

8  Turn off any external hard drives.

Checking the System
Before you use Pro Tools, you may want to run 
the DigiTest diagnostic application to ensure 
that all Pro Tools|HD cards in the system are rec-
ognized, installed in the proper order, and have 
valid TDM FlexCable connections.

Running DigiTest

DigiTest is installed with Pro Tools and resides 
in the following folder on your hard drive: 
Digidesign/Pro Tools/Pro Tools Utilities.

To run DigiTest:

1  Quit Pro Tools if it is running. 

2  Lower the volume of all output devices on 
your system. 

3  Locate and double-click the DigiTest icon on 
your hard drive.

DigiTest opens and lists the supported cards it 
finds in your system, showing their correspond-
ing slot locations.

If you have a large number of cards or audio in-
terfaces, it may take a while for the DigiTest win-
dow to appear, as DigiTest scans for all cards and 
interfaces connected to the system.

Before you run DigiTest, lower the volume 
of all output devices. Very loud digital noise 
may be emitted during the test.

For more information on the DigiTest appli-
cation, see the DigiTest Guide.
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4  Select the cards in your system you want to 
test by selecting Test in the left hand column for 
each card.

5  Click Run.

If cards are not installed in the proper order, 
DigiTest will display error codes in the Status 
box of each card identified as being misconfig-
ured.

The more cards and audio interfaces in your sys-
tem, the longer the test will take. 

DigiTest main test window

The order in which cards are listed within 
DigiTest may not match the actual slot loca-
tions of cards installed in your computer or 
expansion chassis. This is normal, and does 
not affect DigiTest operations in any way. 



6  When prompted, power cycle all Pro Tools pe-
ripherals in your system. Click Continue.

7  To test the interfaces connected to your sys-
tem, check “Test I/O Box.”

8  When the test is finished, you can view the 
test results by doing one of the following:

• Click the Get Results button next to a card 
name.

• Click the Results tab and choose a card slot 
from the pop-up menu.

9  In the Results page of the DigiTest window, 
click Show Failures Only to display failed tests for 
the selected card, or click Show All Results to dis-
play all test results for the selected card. 

10  Click Quit to close DigiTest. 

11  Restart your computer.

Errors and Undetected Cards

Complete the steps below if any of the following 
occur:

� DigiTest fails to launch.

� An error message has been displayed for a card 
in DigiTest.

� A supported card is installed but not automat-
ically detected during DigiTest.

If a supported card is installed and is not 
automatically detected:

1  Quit DigiTest.

2  Turn off the entire Pro Tools system. 

3  Reinstall the Pro Tools|HD cards.

LEDs on your digital interfaces may light up 
during this test. This is normal. 

For descriptions of error codes, refer to “Dig-
iTest Error Codes” on page 39
4  Check the card seating.

5  Check the TDM FlexCable connections. 
Check the orientation of the cable from card to 
card (ports B to A), and check the integrity of the 
FlexCable connections to the cards.

6  Turn on the system. 

7  Run DigiTest again.

DigiTest Error Codes

DigiTest Error Codes

Code Description

Err3 Cards from different Pro Tools 
systems are incorrectly mixed. 
See the configuration chapters.

Err4 Cards marked with this error are 
installed in the wrong order. See 
the configuration chapters. 

Err5 Too many cards of this type are 
installed in the system. Refer to 
the Digidesign website for com-
patibility information.

Err6 A card is installed in a reserve 
slot. For example, a Digidesign 
card is installed in the slot 
reserved for the Expansion Chas-
sis Host Interface card. Refer to 
the configuration chapters, as 
well as related installation guides.

Err1220 SCSI Accelerator card is installed 
in the wrong slot. See the configu-
ration chapters for correct loca-
tion of the card.

Err1221 Expansion Chassis Host Interface 
card is installed in the wrong slot. 
See Expanded Systems Guide for 
correct location of the card.
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Identifying Digidesign Cards with 
DigiTest

You can use DigiTest to identify which cards are 
in which slots in your system. This is especially 
useful if you have multiple Digidesign cards of 
the same type installed in your system. 

To identify Digidesign cards with DigiTest

1  Quit Pro Tools if it is running.

2  Locate and double-click the DigiTest icon on 
your hard drive. 

DigiTest opens and lists the supported cards it 
finds in your system.

3  Open your computer case or expansion chas-
sis so you can see the top edge of the cards in-
stalled in your system. 

4  In the DigiTest window, select the ID check 
box next to a card name. The green LED near the 
top edge of the corresponding card flashes. 

Viewing Card Information with DigiTest

DigiTest can display identifying information 
such as serial number, date of manufacture, and 
firmware ROM version for each card in your sys-
tem. This information is useful if you need to 
contact Digidesign Technical Support about 
your Pro Tools hardware. 

To display information for a card in your system:

1  Quit Pro Tools if it is running.

2  Locate and double-click the DigiTest icon on 
your hard drive.

3  Click the Slot Info tab. 

4  Choose a card slot from the pop-up menu. 
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Updating Audio Peripheral Firmware 
with DigiTest

If firmware updates are available for any of your 
Pro Tools|HD audio interfaces (192 I/O, 
192 Digital I/O, 96 I/O, or 96i I/O), you can use 
DigiTest to perform the update. Within DigiT-
est, the Firmware Update page tells you the firm-
ware version for the selected peripheral and lets 
you update to a newer version, if necessary.

To update the firmware in a Pro Tools|HD audio 
interface:

1  Quit Pro Tools if it is running.

2  Locate and double-click the DigiTest applica-
tion on your hard drive.

3  Click the Firmware tab.

4  Choose a card slot from the pop-up menu. If 
any Pro Tools|HD audio interfaces are con-
nected to the card, the Primary or Secondary op-
tions will become available in the HD Peripheral 
section of the Firmware page.

If any connected interfaces are not recognized, 
check the connections and power to each inter-
face and click Re-Scan. 

5  Under HD Peripheral, select Primary or
Secondary to view the firmware version for the 
corresponding interface. The firmware version is 
displayed just below the HD Peripheral section 
of the Firmware page.

6  If the firmware version is not current, click 
Begin Update to update the firmware in the se-
lected audio interface. 

The status of the firmware update process is dis-
played in the status area at the bottom of the 
Firmware page.

7  After the update process is complete, click Quit 
to close DigiTest. 



Configuring Pro Tools 
Software

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools lets you 
adjust the performance of your system by 
changing system settings that affect its capacity 
for processing, playback, and recording. These 
system settings are available in the Playback En-
gine dialog (Setup > Playback Engine).

In most cases, the default settings for your sys-
tem provide optimum performance, but you 
may want to adjust them to accommodate large 
or processing-intensive Pro Tools sessions. 

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the buffer used to handle host 
processing tasks such as Real-Time AudioSuite™ 
(RTAS) plug-ins. 

• Lower Hardware Buffer Size settings are useful 
for improving latency issues in certain record-
ing situations or for improving certain system 
performance problems.

• Lower settings reduce RTAS MIDI-to-audio 
latency (such as when playing an RTAS vir-
tual instrument live and monitoring the in-
strument’s output). Lower settings can also 
improve screen response or the accuracy of 
plug-in and mute automation data.
• Lower settings reduce monitoring latency 
that occurs on tracks that have one or more 
RTAS plug-ins. Lower settings can also im-
prove the accuracy of MIDI track timing on 
systems that are not using a MIDI I/O (or 
other MIDI interface that supports time 
stamping). Tracks using MIDI virtual in-
struments that do not support time stamp-
ing will also have better MIDI track timing 
with lower settings.

� Higher Hardware Buffer Size settings are use-
ful for sessions that are using more RTAS plug-
ins for playback. These settings allow for more 
audio processing. They can also be useful to re-
duce errors on machines that require a higher 
buffer size.

To change the Hardware Buffer Size:

1  Choose Setup > Playback Engine. 

2  From the H/W Buffer Size pop-up menu, select 
the audio buffer size, in samples.

3  Click OK. 

Playback Engine dialog for Pro Tools|HD system
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RTAS Processors

The RTAS Processors setting determines the 
number of processors in your computer allo-
cated for RTAS (Real-Time AudioSuite) plug-in 
processing.

With multiprocessor computers, this setting lets 
you manage multi-processor support for RTAS 
processing. With multiple processor computers 
that support Hyper-Threading (and have it en-
abled), you must disable Hyper-Threading for 
this setting to become available. See your com-
puter’s documentation for steps on how to enter 
the computer’s BIOS and disable Hyper-Thread-
ing.

Used in combination with the CPU Usage Limit 
setting, the RTAS Processors setting lets you con-
trol the way RTAS processing and other 
Pro Tools tasks are carried out by the system. For 
example:

• For sessions with large numbers of RTAS plug-
ins, you can allocate 2 or more processors to 
RTAS processing and set a high CPU Usage 
Limit.

• For sessions with few RTAS plug-ins, you can 
allocate fewer processors to RTAS and set a low 
CPU Usage Limit to leave more CPU resources 
available for automation accuracy, screen re-
sponse, and video. 

• Increase these settings to accommodate TDM 
to RTAS plug-in conversion. Conversely, de-
crease these settings if you are only using 
TDM plug-ins or are converting RTAS plug-ins 
to TDM. TDM/RTAS conversion can be desir-
able during recording, depending on latency, 
voicing needs, and record-monitoring capa-
bilities of the specific TDM and RTAS plug-ins. 
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• Depending on the importance of video and 
overall screen response, and on the density of 
automation being employed, try different 
combinations of RTAS Processing and CPU 
Usage Limit settings to achieve the best re-
sults. For example, to improve screen re-
sponse in a medium-sized session using a 
moderate number of RTAS plug-ins, try reduc-
ing the number of RTAS plug-ins, but keep the 
CPU Usage Limit set to the maximum (99%) 
on a single processor system.

To set the number of RTAS Processors:

1  Choose Setup > Playback Engine. 

2  From the RTAS Processors pop-up menu, select 
the number of available processors you want to 
allocate for RTAS plug-in processing. The num-
ber of processors available varies depending on 
how many processors are available on your com-
puter:

• Choose 1 Processor to limit RTAS process-
ing to one CPU in the system. 

• Choose 2 Processors to enable load balanc-
ing across two available processors.

• On systems running four or more proces-
sors, choose the desired number of RTAS 
processors as needed.

3  Click OK.

CPU Usage Limit

The CPU Usage Limit controls the percentage of 
CPU resources allocated to Pro Tools host pro-
cessing tasks. Used in combination with the 
RTAS Processors setting, the CPU Usage Limit 
setting lets you control the way Pro Tools tasks 
are carried out by the system.



� Lower CPU Usage Limit settings limit the ef-
fect of Pro Tools processing on other CPU-inten-
sive tasks, such as screen redraws, and are useful 
when you are experiencing slow system re-
sponse, or when running other applications at 
the same time as Pro Tools.

� Higher CPU Usage Limit settings allocate 
more processing power to Pro Tools, and are use-
ful for playing back large sessions or using more 
real-time plug-ins. 

The maximum available CPU Usage Limit de-
pends on the number of processors in your com-
puter and on the number of processors you spec-
ify for RTAS processing. This value can range 
from 85 percent for single-processor computers 
to 99 percent for multi-processor computers.

On multiprocessor computers, the maximum 
CPU Usage Limit is reduced when you use all 
your processors (as selected in the RTAS Process-
ing pop-up menu). For example, on dual-proces-
sors, the limit will be 90%. On four-processor 
computers, the limit will be 95%.

To change the CPU Usage Limit:

1  Choose Setup > Playback Engine. 

2  From the CPU Usage Limit pop-up menu, se-
lect the percentage of CPU processing you want 
to allocate to Pro Tools. 

3  Click OK.

Increasing the CPU Usage Limit may slow 
down screen responses on slower computers.
RTAS Engine (RTAS Error Suppression)

The RTAS Engine option determines RTAS error 
reporting during playback and recording. This is 
especially useful when working with instrument 
plug-ins.

You should only enable RTAS error suppression 
if you are experiencing frequent RTAS errors 
that are interrupting your creative workflow. 
When RTAS error suppression is enabled, you 
can experience a degradation of audio quality. 
However, this may be acceptable in order to 
avoid interrupting playback and recording 
when working with instrument plug-ins. Be sure 
to disable RTAS error suppression when you 
need to ensure the highest possible audio qual-
ity, such as for a final mix.

To enable RTAS error suppression:

1  Choose Setup > Playback Engine. 

2  Select Ignore Errors During Playback/Record.

3  Click OK.

RTAS Error Suppression Option

On Pro Tools|HD systems, there is a single RTAS 
Engine option:

Ignore Errors During Playback/Record When en-
abled, Pro Tools continues to play and record 
even if the RTAS processing requirements ex-
ceed the selected CPU Usage Limit. This can re-
sult in pops and clicks in the audio, but does not 
stop the transport.
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Number of Voices

The Number of Voices setting lets you control 
the number of voices available on your system. 
For example, the default number of voices on an 
Pro Tools|HD 1 system is 48 voices, using one 
DSP (at sample rates of 44.1 kHz or 48 kHz). 

Changing the number of voices affects 
DSP usage, the total number of voiceable tracks, 
and overall system performance. 

Depending on the current sample rate and the 
number of cards in your system, and whether 
you are using an expansion chassis, you will 
have different choices for voice count. 

To change the Number of Voices and DSP to 
allocate for voicing:

1  Choose Setup > Playback Engine. 

2  Select the number of voices and DSPs to allo-
cate for voicing by choosing a value from the 
Number of Voices pop-up menu. 

• Select minimum voice numbers if you are 
using high-bandwidth PCI or PCIe cards 
(such as video capture cards) along with 
your Digidesign cards. These settings place 
the lightest processing load on each allo-
cated DSP chip, but generally require more 
DSP chips be dedicated to voicing and mix-
ing (leaving fewer available for plug-ins). 

• Select medium voice numbers when your 
Digidesign cards are in an expansion chas-
sis, or when you are using other PCI or PCIe 
cards along with Digidesign cards. These 
settings generally provide an optimum bal-
ance between number of chips needed for 
voicing, and the processing load placed on 
each. 

For additional information on voice count, 
refer to the Pro Tools Reference Guide.
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• Select higher voice numbers when your 
Digidesign cards are the only PCI or PCIe 
cards in your computer, or when you are 
using an expansion chassis to run higher 
track counts (such as 64 tracks at 96 kHz) 
and you want more voices per DSP (such as 
16 voices per DSP at 96 kHz). These settings 
use fewer DSP chips for mixing (leaving 
more available for plug-ins) but place the 
highest processing load on each. 

3  Click OK. 

Default Sample Rate

The Sample Rate setting determines the default 
sample rate when you create a new session. This 
setting is available only when there is no session 
open. Otherwise, the current session sample rate 
is displayed, but cannot be changed.

Number of Voices menu (HD|1-equipped system)

The Sample Rate setting can affect the 
number of available voices.



To change the default Sample Rate in the 
Playback Engine:

1  Choose Setup > Playback Engine. 

2  Select the sample rate from the Sample Rate 
pop-up menu.

3  Click OK.

Delay Compensation Engine

The Delay Compensation Engine determines 
how much DSP resources are dedicated for Delay 
Compensation, which managing DSP delays in 
the Pro Tools mixer.

Within a session, you can choose to enable or 
disable Delay Compensation (Options > Delay 
Compensation).

Delay Compensation automatically manages 
DSP delays that occur on audio tracks, Auxiliary 
Inputs, or Master Faders because of plug-in use 
and mixer routing. With Delay Compensation 
enabled, Pro Tools maintains phase coherent 
time alignment between track outputs that have 
plug-ins with differing DSP delays, tracks with 
different mixing paths, tracks that are split off 
and recombined within the mixer, and tracks 
with hardware inserts. 

You can change the sample rate when 
creating a new Pro Tools session by 
selecting a different sample rate in the 
New Session dialog.

You can also change the default Sample 
Rate in the Hardware dialog, as long as 
no session is open.
To maintain phase coherent time alignment, 
Pro Tools adds the exact amount of delay to 
each track necessary to make that particular 
track’s delay equal to the total system delay. The 
System Delay is shown in the Session Setup win-
dow.

Delay Compensation should be enabled during 
mixing and playback for phase coherent time 
alignment between track outputs.

When recording, in most cases Delay Compen-
sation can be enabled. However, it is still recom-
mended that you disable Delay Compensation 
for certain dubbing workflows (such as when re-
cording to multiple audio tracks in series).

To configure the Delay Compensation Engine:

1  Choose Setup > Playback Engine. 

2  From the Delay Compensation Engine pop-up 
menu, select a Delay Compensation setting.

3  Click OK.

With Delay Compensation enabled, it is 
recommended that you do not use any in-
serts on any Auxiliary Input or Master 
Fader tracks you may be using to control the 
cue mix volume. Also, you should avoid us-
ing inserts on any record tracks. (Some low 
latency inserts may be acceptable depend-
ing on the talent∂s preference.)

For more information on using Delay Com-
pensation, see the Pro Tools Reference 
Guide.
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Delay Compensation Settings

There are three settings in the Playback Engine 
dialog for dedicating DSP resources for Delay 
Compensation: 

None Allocates no DSP resources for Delay Com-
pensation.

Short Allocates minimum DSP resources of De-
lay Compensation for each channel. This is the 
most efficient setting for Pro Tools|HD Accel 
systems. For sessions with only a few plug-ins 
that do not induce too much DSP-based delay, 
this setting should be sufficient.

Long Allocates maximum DSP resources for De-
lay Compensation for each mixer channel. For 
sessions with a lot of plug-ins resulting in a large 
amount of DSP-induced delay, select this set-
ting.

DAE Playback Buffer Size

The DAE Playback Buffer Size determines the 
amount of memory DAE allocates for disk buff-
ers. In addition to levels, the DAE Playback 
Buffer Size shows values in milliseconds, which 
indicates the amount of audio buffered when 
the system reads from disk. 

The optimum DAE Playback Buffer Size for most 
disk operations is 1500 msec (Level 2). 

• DAE Playback Buffer Size settings lower than 
1500 msec (Level 2) may improve playback and 
recording initiation speed. However, a lower set-
ting may make it difficult to play or record 
tracks reliably with sessions containing a large 
number of tracks or a high density of edits, or 
with systems that have slower or heavily frag-
mented hard drives.
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• DAE Playback Buffer Size settings higher than 
1500 msec (Level 2) allow higher track count, 
higher density of edits in a session, or the use of 
slower hard drives. However, a higher setting 
may increase the time lag when starting play-
back or recording, or cause a longer audible time 
lag while editing during playback.

To change the DAE Playback Buffer Size:

1  Choose Setup > Playback Engine.

2  From the DAE Playback Buffer pop-up menu, 
select a buffer size. Memory requirements for 
each setting are shown at the bottom of the 
Playback Engine dialog.

3  Click OK. 

If Pro Tools needs more system memory for the 
DAE Playback Buffer, it will prompt you to re-
start your computer.

Using a larger DAE Playback Buffer Size 
leaves less system memory for other tasks. 
The default setting of 1500 msec (Level 2) is 
recommended unless you are encountering 
-9073 (“Disk too slow or fragmented”) 
errors. 

Playback Buffer Size menu in the Playback Engine 
dialog



Cache Size

The Cache Size determines the amount of mem-
ory DAE allocates to pre-buffer audio for play-
back and looping when using Elastic Audio. 

The optimum Cache Size for most sessions is 
Normal.

• A Cache Size setting of Minimum reduces the 
amount of system memory used for disk opera-
tions and frees up memory for other system 
tasks. However, using Elastic Audio features at 
this setting may decrease performance.

• A Cache Size of Large improves performance 
when using Elastic Audio features, but it also de-
creases the amount of memory available for 
other system tasks, such as RTAS processing.

To change the Cache Size:

1  Choose Setup > Playback Engine.

2  From the Cache Size pop-up menu, select a 
disk cache size.

3  Click OK. 

Using a larger Cache Size leaves less system 
memory for other tasks. The default setting of 
Normal is recommended unless you are en-
countering -9500 (“Cache too small”) errors. 

Cache Size menu in the Playback Engine dialog
System Memory Allocation

When you start your computer, Pro Tools auto-
matically reserves a portion of system memory 
for the DAE Playback Buffer. This reserved mem-
ory is unavailable to other applications, even if 
Pro Tools is not running. 

You can set Pro Tools to reserve only the mini-
mum amount of required memory, so that more 
system memory is available to other applica-
tions. 

To minimize system memory allocation:

1  Choose Setup > Playback Engine.

2  Select the “Minimize System Memory Allocation” 
option. 

3  Click OK. 

4  Restart your computer. 

Plug-in Streaming Buffer Size

(Structure Plug-in Only)

This setting appears in the Playback Engine dia-
log only if the Structure sampler instrument 
plug-in is installed on your system. The Plug-in 
Streaming Buffer Size determines the amount of 
memory DAE allocates for streaming playback 
from disk with the Structure plug-in. This set-
ting only affects playback if disk streaming is ac-
tivated in Structure’s plug-in controls (see the 
Structure Plug-in Guide for more information).

The optimum Plug-in Streaming Buffer Size for 
most sessions is 250 ms (Level 2).

• Plug-in Streaming Buffer Size settings lower 
than 250 msec (Level 2) reduce the amount of 
system memory used for sample playback and 
frees up memory for other system tasks. How-
ever, reliability of sample playback may de-
crease.
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• Plug-in Streaming Buffer Size settings higher 
than 250 msec (Level 2) improve the reliability 
of sample playback, but they also decrease the 
amount of memory available for other system 
tasks, such as RTAS processing.

To change the Plug-in Streaming Buffer Size:

1  Choose Setup > Playback Engine.

2  From the Plug-in Streaming Buffer Size pop-up 
menu, select a buffer size.

3  Click OK. 

Using a larger Plug-in Streaming Buffer Size 
leaves less system memory for other tasks. 
The default setting of 250 ms (Level 2) is 
recommended unless you are experiencing 
problems with the reliability of streaming 
playback from disk.

Plug-in Streaming Buffer Size menu in the Playback 
Engine dialog
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Optimizing the Plug-in Streaming Buffer 
Size

(Structure Plug-in Only)

This option appears in the Playback Engine dia-
log only if the Structure sampler instrument 
plug-in is installed on your system. This option 
is useful when you are playing samples from the 
same drive that contains audio for the current 
session. When this option is selected, Pro Tools 
automatically optimizes the size of the Plug-in 
Streaming Buffer to facilitate disk access from 
both Pro Tools and Structure. The Plug-in 
Streaming Buffer Size pop-up menu is unavail-
able when this option is selected.

To set Pro Tools to automatically optimize the 
Plug-in Streaming Buffer Size:

1  Choose Setup > Playback Engine.

2  Select the Optimize for Streaming Content on Au-
dio Drives option.

3  Click OK. 

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, 
do one of the following:

� On Windows, configure your MIDI setup with 
MIDI Studio Setup. See Appendix C, “Configur-
ing MIDI Studio Setup (Windows Only)” for de-
tails.

– or –

� On Mac, configure your MIDI setup with Au-
dio MIDI Setup. See Appendix D, “Configuring 
AMS (Mac OS X Only)” for details.



Configuring Pro Tools Hardware 
Settings

In the Hardware Setup dialog, Pro Tools lets you 
set the default sample rate and clock source for 
your system, as well as a range of controls spe-
cific to each type of audio interface.)

Default Sample Rate

The Sample Rate setting appears as the default 
sample rate when you create a new session. (This 
setting is available in the Hardware Setup dialog 
only when no session is open.) 

To change the default Sample Rate:

1  Choose Setup > Hardware.

2  Choose the sample rate from the Sample Rate 
pop-up menu.

3  Click OK.

You can change the sample rate when 
creating a new Pro Tools session by 
selecting a different sample rate in the 
New Session dialog.

Hardware Setup dialog for 192 I/O, Main page
High Sample Rates and Expanded Systems

With 176.4 kHz and 192 kHz sample rates, as 
many as four Pro Tools|HD cards can be used. 
Any additional cards (up the total system maxi-
mum of seven cards) will switch to Inactive 
mode. The cards and any attached peripherals 
will become active again when the sample rate is 
set to 96 kHz or lower. See the Pro Tools Ex-
panded Systems Guide for more information. 

Clock Source

The Pro Tools Hardware Setup dialog lets you se-
lect the Clock Source for the system.

Internal If you are recording an analog signal di-
rectly into Pro Tools, you will usually use the 
Pro Tools Internal clock source. 

External If you are transferring material into 
Pro Tools from an external digital device, or if 
you utilize a common house clock signal, you 
will synchronize Pro Tools to that digital device 
or common signal. Depending on your audio in-
terface, external options can include AES/EBU 
[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, 
TDIF, ADAT, and Word Clock. For details, refer 
to the Pro Tools Reference Guide or the guide for 
your audio interface. 

To select the Clock Source:

1  Choose Setup > Hardware. 

2  Choose the clock source from the Clock 
Source pop-up menu.

3  Click OK. 

Your digital input device must be connected 
and powered on for Pro Tools to synchro-
nize to it. If your input device is not powered 
on, leave the Clock Source set to Internal.
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Configuring Audio Interfaces

Pro Tools|HD audio interfaces support 16 chan-
nels of simultaneous I/O and multiple I/O for-
mats (including analog, AES/EBU, ADAT Opti-
cal, S/PDIF, and TDIF).

The Main page of the Hardware Setup dialog is 
where you define which physical inputs and 
outputs on your audio interface are routed to 
available inputs and outputs in Pro Tools. You 
can think of this window as a patchbay that al-
lows you to route any of the inputs or outputs 
on your Pro Tools|HD audio interfaces to chan-
nel assignments in the Pro Tools mixer.

The Main page also provides controls for defin-
ing whether Expansion Port or Legacy Port pe-
ripherals are active. 

Additional pages are available to configure other 
controls for each audio interface (such as setting 
operating levels).

Identifying Audio Interfaces

If you have multiple audio interfaces of the 
same type connected to your system, before you 
make audio connections to them, you should 
confirm the identity of each interface. This en-
sures that you choose the appropriate interface 
in the Peripherals list when you define its inputs 
and outputs in the Hardware Setup dialog. 

Hardware Setup dialog for 192 I/O, Main page
Pro Tools|HD Setup Guide
To identify audio interfaces in your system:

1  Choose Setup > Hardware.

2  From the Peripherals list, select an audio inter-
face connected to your system.

3  Make sure the Main page is shown.

4  Select the Identify option, located in the lower 
left corner of the Hardware Setup dialog. This il-
luminates all the LEDs on the front panel of the 
selected audio interface. 

5  Make a note of which interface in your studio 
setup corresponds to the identified interface. 

6  Repeat the above steps for each additional au-
dio interface in your setup.

To configure Pro Tools|HD audio interfaces:

1  Choose Setup > Hardware.

2  From the Peripherals list, select the Digidesign 
audio interface connected to the first card in 
your system. This will be the interface at the top 
of the list.

3  Click the Main tab.

4  From the Clock Source pop-up menu, select 
the appropriate clock source for the interface.

Use the Up and Down Arrow keys to scroll 
though the Peripherals list in the Hardware 
Setup dialog.

Legacy I/Os must be initialized in the Pe-
ripherals list before they can be identified. 
See “Configuring Legacy I/Os” on page 54.



In many cases, you will use Internal. The other 
choices are for resolving Pro Tools to external 
clock sources. Depending on your audio inter-
face, Clock Source options can include: AES/EBU 
[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, TDIF, 
ADAT, and Word Clock (optional Word Clock 
rates are available when operating at higher 
sample rates).

5  If you want to send clock output to other de-
vices attached to the audio interface, select the 
appropriate output from the Ext. Clock Output 
pop-up menu. 

If the Legacy I/O Port is enabled (and not the 
Expansion I/O Port) then the Ext. Clock Output 
automatically switches to Slave Clock (256x sam-
ple rate). To reset the Ext. Clock Output to Word 
Clock, change the Port Settings back to 
Expansion I/O, then select the Legacy I/O in the 
Peripherals list, and set it to No Interface in the 
Interface pop-up menu. (The 96i I/O does not 
support Legacy I/O.) 

6  Select which digital I/O port on your audio in-
terface enclosure is active by selecting an option 
under Digital Format. Depending on the type of 
interfaces in your system, choices include 
AES/EBU, S/PDIF, and Optical (S/PDIF). Selecting 
Optical (S/PDIF) resets the Optical I/O port 
(which is, by default, eight channels of 
ADAT Optical I/O) to two channels of 
S/PDIF Optical I/O. (The 96i I/O supports stereo 
S/PDIF RCA digital input and output only.) For 
more information about Pro Tools|HD enclosure 
and card ports, refer to the guide for your audio 
interface.

7  For S/PDIF compatibility with Tascam DA-30 
DAT recorders, select the Tascam option under 
S/PDIF Format.

8  For the 96 I/O and 96i I/O, click the Meters 
pop-up menu and select whether to meter the 
input or output signal.
9  From the Input and Output channel pop-up 
menus, select the physical ports (such as Analog 
1–2 or Optical 1–2), that will be routed to the 
corresponding Pro Tools input and output chan-
nels (such as Ch 1–2, Ch 3–4), listed on the left 
side of the Main page. (This feature is not avail-
able with the 96i I/O.) 

Inputs and outputs of similar format are differ-
entiated in the input and output channel pop-
up menus. For example, the AES/EBU inputs and 
outputs in the 192 I/O enclosure are listed as 
AES/EBU [Encl], while the AES/EBU inputs and 
outputs on the factory-installed Digital I/O card 
are listed (in pairs) as AES/EBU 1–2, AES/EBU 
3–4, AES/EBU 5–6, and AES/EBU 7–8. For 
192 I/Os equipped with the optional Digital I/O 
Card, the additional AES/EBU I/O ports on the 
optional card are listed as AES/EBU 9–10, 
AES/EBU 11–12, AES/EBU 13–14, and AES/EBU 
15–16.

10  Configure controls for your Pro Tools|HD au-
dio interface. See “Configuring 192 I/O and 
192 Digital I/O Controls” on page 52, “Config-
uring 96 I/O Controls” on page 53, and “Con-
figuring 96i I/O Controls” on page 53.

11  For additional Pro Tools|HD interfaces, 
choose the interface in the Peripherals list, and 
repeat the above steps.

Refer to your peripheral’s guide for configu-
ration details and restrictions. For example, 
the Optical 1–8 channels (on the 192 I/O 
enclosure) will not be available at session 
sample rates of 88.2 kHz or higher, while 
the ports on the 192 I/O Digital I/O card 
will still be available.
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Configuring 192 I/O and 192 Digital I/O 
Controls

To configure controls for a 192 I/O:

1  With the 192 I/O selected in the Peripherals 
list, click the Analog In tab for the following op-
tions:

• You can set your operating level on a chan-
nel-by-channel basis by selecting Reference 
Level +4 dBu or –10 dBV. These settings 
correspond to two different input connec-
tors on the back of the 192 I/O. Refer to the 
192 I/O Guide for more information on set-
ting operating levels. 

• Each of the analog channels in the 192 I/O 
has two Input Trims, labeled A and B, for 
precisely calibrating and switching levels. 
You can select Input Trim A or B on a chan-
nel-by-channel basis. Refer to the 192 I/O 
Guide for information on setting the rear 
panel trims.

• You can select Soft Clip on a channel-by-
channel basis. The Soft Clip limiter attenu-
ates the incoming analog signal, providing 
extra protection from temporary clipping 
transients that can cause digital distortion 
when they exceed the maximum input of 
the unit. With Soft Clip enabled, 192 I/O 
supports an additional 4 dB of headroom 
by rounding off the top 4 dB to the clip 
point. This is useful for eliminating stray 
transients or for emulating analog tape sat-
uration.

Hardware Setup dialog for 192 I/O, Analog In page
Pro Tools|HD Setup Guide
2  Click the Analog Out tab for the following op-
tion:

• Each of the analog channels in the 192 I/O 
has two Output Trims, labeled A and B, re-
spectively. You can select Output Trim A or 
B on a channel-by-channel basis.

To configure controls for a 192 Digital I/O or 
192 I/O with an optional Digital I/O card:

� On the 192 Digital I/O or a 192 I/O with an 
optional Digital I/O card, click the Digital tab to 
set the Input Format (AES/EBU, TDIF, or ADAT 
Optical) and enable real-time sample rate con-
version (in channel pairs, with the SR Conver-
sion option).

Hardware Setup dialog for 192 I/O, Analog Out page

At session sample rates above 48 kHz, sam-
ple rate conversion for the TDIF and Optical 
(ADAT) inputs on the Digital I/O card is au-
tomatically enabled on all eight inputs of 
the selected format. 

Hardware Setup dialog for 192 I/O, Digital page



Configuring 96 I/O Controls

To configure controls for a 96 I/O:

1  With the 96 I/O selected in the Peripherals 
list, configure your I/O front panel meters for in-
put or output metering from the Meters pop-up.

2  Click the Analog In tab for the following op-
tion:

• You can set your operating level on a chan-
nel-by-channel basis by selecting Reference 
Level +4 dBu or –10 dBV. Refer to the 96 I/O 
Guide for more information on setting op-
erating levels.

3  Click the Analog Out tab for the following op-
tion:

• You can set your output level on a channel-
by-channel basis by selecting Reference 
Level +4 dBu or –10 dBV. Refer to the 96 I/O 
Guide for more information on setting op-
erating levels.

Hardware Setup dialog for 96 I/O, Analog In page

Hardware Setup dialog for 96 I/O, Analog Out page
Configuring 96i I/O Controls

To configure controls for a 96i I/O:

1  With the 96i I/O selected in the Peripherals 
list, configure your I/O front panel meters for in-
put or output metering from the Meters pop-up.

2  Set input sensitivity by doing the following: 

• For Inputs 1–4, set the input trim slider to 
match the output level of the connected in-
strument. Choices range from –12 dBV to 
+4 dBu. If you do not know the output 
level of the device, use the default input 
trim level, then fine tune the input level 
sensitivity.

• For each input 5–16 being used, select 
–8 dBV or +4 dBu as appropriate to best 
match the output level of the connected in-
strument. 

3  Set Output levels (select –10 dBV or +4 dBu).

4  Click Done.

You can select analog or digital input as sources 
for 96i I/O channels 1–2. Only channels 1–2 can 
access the S/PDIF inputs. 

Hardware Setup for 96i I/O
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To select analog or digital input for channels 1-2:

1  Choose Setup > Hardware, and select 96i I/O in 
the Peripherals list to display the 96i I/O win-
dow. 

2  Click to set Ch 1–2 Input to Analog or S/PDIF, 
as appropriate. 

Configuring Legacy I/Os

Before you can configure a Legacy I/O, it must 
first be initialized in Hardware Setup.

To initialize a Legacy I/O on a Pro Tools|HD 
system:

1  Lower the volume of your output devices.

2  Start up your Pro Tools system (see “Starting 
Up or Shutting Down Your System” on page 37).

3  In Pro Tools, choose Setup > Hardware.

4  From the Peripherals list, choose the primary 
audio interface (the interface to which your Leg-
acy I/O is connected).

5  In the Main page of the Hardware Setup dia-
log, select the Legacy I/O option under Port Set-
tings.

6  In the Peripherals list, No Interface is listed 
twice, directly below the primary audio inter-
face. Click the first No Interface. An Interface 
pop-menu appears in the Hardware Setup dia-
log, listing supported I/O choices.

The 96i I/O only supports analog and digi-
tal switching for channels 1–2, and only 
from within the Hardware Setup and I/O 
Setup dialogs. The 96i I/O does not support 
path remapping within I/O Setup.

Before turning on your Legacy I/O, make 
sure to lower the volume of your output de-
vices. Very loud digital noise may be emit-
ted before the Legacy I/O is initialized.
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7  From the Interface pop-up, select the type of 
Legacy I/O you connected.

After you select the type of Legacy I/O, the Main 
page updates with controls that can be config-
ured. If your Legacy interface does not appear, 
check connections and repeat from step 1, 
above.

8  Repeat the above steps for each additional 
Legacy I/O.

9  Click OK to close the Hardware Setup dialog.

To remove a Legacy I/O:

1  Lower the volume of your output devices.

2  Turn off your Legacy I/O.

3  In Pro Tools, choose Setup > Hardware.

4  In the Peripherals list, select the name of a 
Legacy interface. 

5  From the Interface pop-up menu, choose No 
Interface.

6  Repeat steps 4–5 for each additional Legacy 
I/O.

7  In the Peripherals list, select the name of the 
the Pro Tools|HD audio interface to which the 
Legacy I/O was connected. 

8  Select the Expansion I/O option under Port Set-
tings.

9  Click OK to close the Hardware Setup dialog.

Offline Peripherals

When a Legacy I/O and Pro Tools|HD peripheral 
are connected to your primary Pro Tools|HD pe-
ripheral, only one can be online at a time. An of-
fline peripheral is indicated by brackets in the 

For information on Hardware Setup controls 
for each Legacy I/O, refer to the guide for that 
interface.



Peripherals list of the Hardware Setup dialog. For 
example, if you have a 96 I/O and an 882|20 
connected to a 192 I/O, and the 96 I/O is offline, 
it will appear in the Peripherals list as “[96 I/O].”

Peripherals will also go offline if the audio inter-
face or card to which they are attached is made 
inactive. 

Configuring I/O Setup

The I/O Setup dialog provides a graphical repre-
sentation of the signal routing for each con-
nected audio interface, with controls to route 
physical ports on the audio interface to 
Pro Tools inputs and outputs. These controls 
mirror the routing controls found in the Hard-
ware Setup dialog—changes made to physical 
routing in one dialog are always reflected in the 
other. 

The I/O Setup dialog also lets you label and map 
Pro Tools input, output, insert, and bus signal 
paths. The I/O Setup dialog also provides impor-
tant audition, meter, and surround settings.

Pro Tools comes with default I/O Setup settings 
that will get you started. You only need to go to 
I/O Setup if you want to remap or rename the 
default I/O paths or if you change your system 
hardware (for example, adding an expansion 
card to a 192 I/O).

To configure I/O routing in I/O Setup:

1  Choose Setup > I/O.

2  Click the Input or Output tab to display the 
corresponding connections. 

3  To change the name of a path or subpath, dou-
ble-click directly on the Path Name, type a new 
name for the path, and press Enter. 

Refer to the Pro Tools Reference Guide for 
more information on setting up I/O paths.
4  To change the destination of an Input or Out-
put path or subpath, click directly on an Input 
or Output Selector for an interface channel pair, 
just below an audio interface icon. (This feature 
is not available for the 96i I/O.)

5  From the pop-up menu, select a physical port 
pair (such as Analog 1–2), to route to the corre-
sponding Pro Tools channel pair (such as A 1–2) 
in the Path Name column on the left. 

6  Repeat the above steps for additional channel 
pairs.

7  Click OK.

Routing a Pro Tools Output Pair to 
Multiple Destinations

Pro Tools channel pairs can be routed to multi-
ple outputs on your Digidesign audio interface 
through the Hardware Setup dialog. 

For example, if you assign both Analog 1–2 and 
Analog 3–4 interface outputs to Pro Tools Out-
put pair 1–2, when you send a signal to 
Pro Tools Output pair 1–2, that signal will be 
routed simultaneously to both pairs of output 
ports on your audio interface.

I/O Setup dialog for Pro Tools|HD system
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This lets you send the same signal (such as a ste-
reo pair, a stem mix, or a multichannel mix) to 
multiple destinations (such as multiple master-
ing devices).

To route a Pro Tools output channel pair to 
multiple audio interface output ports:

1  Choose Setup > Hardware.

2  From the Peripherals list, select an interface.

3  Click the Main tab. 

4  Select an output pair from an Output pop-up 
menu. 

5  Start-click (Windows) or Control-click (Mac) 
the same pop-up menu a second time to choose 
an additional output port pair.

The output name updates with a plus sign (“+”) 
before it to indicate that multiple output ports 
are selected. In the pop-up menu, each physical 
port pair assigned to that Pro Tools output pair 
is indicated by a check mark.

6  Repeat the above steps to select additional 
output destinations. The only limit to output 
choices is the number of outputs available in 
your system.

Pro Tools output pairs can also be routed to mul-
tiple audio interface outputs in the I/O Setup di-
alog. For more information, see the Pro Tools Ref-
erence Guide.

Hardware Setup dialog for 96 I/O, Main page
Pro Tools|HD Setup Guide
Backing Up Your System 
Configuration

After configuring your system and Pro Tools, 
you should save an image of your system drive 
using a backup utility such as Acronis True Im-
age or Norton Ghost (Windows), or Bombich 
Carbon Copy Cloner (Mac). By doing this, you 
can quickly restore your system configuration 
and settings if you encounter any problems.

Optimizing a Windows System 
for Pro Tools
To ensure optimum performance with 
Pro Tools|HD, configure your computer before 
using Pro Tools hardware and software.

Before configuring your computer, make sure 
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For 
details on Administrator privileges, see your 
Windows documentation.

Required Optimizations

To ensure optimum performance with 
Pro Tools, configure the following settings be-
fore using Pro Tools hardware and software.

For Mac System Optimization, see “Opti-
mizing a Mac System for Pro Tools” on 
page 59.

When you are finished changing Windows 
system settings, restart your computer.



Enabling DMA

Enabling your computer's DMA (Direct Memory 
Access) frees up CPU bandwidth so your com-
puter can do other Pro Tools tasks.

In most cases the DMA option will already be set 
correctly, as Windows detects and activates 
DMA mode by default.

To enable DMA for any IDE hard drives:

1  Right-click My Computer (Windows XP) or 
Computer (Windows Vista).

2  In the left-hand pane of the Computer Man-
agement window under System Tools, click on 
Device Manager.

3  In the right-hand pane, click the plus (+) sign 
to expand IDE ATA/API Controllers.

4  Right-click on the Primary IDE Controller and se-
lect Properties.

5  Click the Advanced Settings tab.

6  For each device, do one of the following de-
pending on your operating system:

• Set the Transfer Mode to DMA if available 
(WIndows XP)

– or –

• Check the box Enable DMA (Windows 
Vista)

7  Click OK.

8  Repeat the above steps for any additional IDE 
Channels.

9  Close the Computer Management window.

Disabling User Account Control

(Windows Vista Only)

For optimal performance with Pro Tools on 
Windows Vista, disable User Account Control 
(UAC).
To disable User Account Control (UAC):

1  Choose Start > Control Panel.

2  Double-click User Accounts.

3  Click “Turn User Account Control on or off.”

4  Deselect the “Use User Account Control (UAC) to 
help protect your computer” option.

5  Click OK.

Disabling System Standby and Power 
Management

When using Pro Tools, the Windows System 
Standby power scheme must be set to Always On. 
This helps prevent long record or playback 
passes from stopping due to system resources 
powering down. 

To configure Windows Power Management 
(Windows Vista):

1  Choose Start > Control Panel.

2  Double-click Power Options.

3  In the Power Options window, select High Per-
formance.

4  Click Change plan settings.

5  In the Edit Plan Settings window, click Change 
advanced power settings.

6  In the Power Options dialog, reveal Hard disk > 
Turn off hard disk after.

7  Click Setting option.

8  Select the value in the Setting (Minutes) field 
and press Backspace on your computer key-
board.

9  Press Enter. The hard disk setting changes to 
Never and the Power Options dialog closes.

10  In the Edit Plan Settings window, click Save 
changes and close the window.
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To configure Windows Power Management 
(Windows XP):

1  Choose Start > Control Panel.

2  Double-click Power Options.

3  Click the Power Schemes tab.

4  From the Power Schemes pop-up menu, select 
Always.

5  Verify that the following settings are set to 
Never:

• Turn off hard disks 

• System standby 

• System hibernates 

6  Click OK. 

Recommended Optimizations

Pro Tools can also be affected by other software 
and hardware drivers installed on your com-
puter. For best possible performance, it is recom-
mended (but not required) that you do the fol-
lowing:

• Avoid running any unneeded programs at 
the same time as Pro Tools.

• Turn off any software utilities that run in 
the background, such as Windows Messen-
ger, calendars, and disk maintenance pro-
grams. 

• Turn off any non-essential USB devices 
while running Pro Tools.

• If your video display card supports it, en-
able Bus Mastering in the manufacturer’s 
Control Panel. See the manufacturer’s in-
structions for details.
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Optional Optimizations

The following system optimizations may help 
Pro Tools perform better on some systems. It is 
recommended that you only try these optimiza-
tions if necessary, as they may disable or ad-
versely affect the functionality of other pro-
grams on your system.

Disabling Network Cards

If applicable, disable any networking cards 
(other than a FireWire card that you might use 
to connect an external drive to your system).

To disable a network card:

1  Right-click My Computer (Windows XP) or 
Computer (WIndows Vista) and choose Manage.

2  Under System Tools, select Device Manager.

3  In the Device Manager window, double-click 
Network adapters, then double-click the Network 
Adapter card you want to disable.

4  Under the General tab, choose “Do not use this 
device (disable)” from the Device Usage pop-up 
menu, and click OK.

5  Close the Computer Management window.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1  Right-click My Computer (Windows XP) or 
Computer (WIndows Vista) and choose Proper-
ties.

2  in the System Properties window, click the
Advanced tab.

3  Under the Performance section, click the 
Settings button.

4  In the Performance Options window, click the 
Advanced tab.



5  Under the Processor Scheduling section, select 
the Background Services option.

6  Under the Memory Usage section, select the 
System cache option.

7  Click OK to close the Performance Options 
window. 

8  Click OK to close the System Properties win-
dow.

9  Restart the computer for the changes to take 
effect.

Disabling System Startup Items

The fewer items in use by your computer, the 
more resources are available for Pro Tools. Some 
startup applications may be consuming unnec-
essary CPU resources, and can be turned off. 

If you disable any of the following startup items, 
do so carefully:

• Portable media serial number (required for 
some applications that utilize a copy pro-
tection key)

• The Plug and Play service

• Event log

• Cryptographic services

To Disable System Startup Items:

1  From the Start menu, type “msconfig” in Run 
(Windows XP) or in Start Search (Windows 
Vista) and click OK to open the System Configu-
ration Utility.

2  Under the General tab, choose Selective Star-
tup.

3  Deselect Load Startup Items and click OK.

4  Click Restart to restart the computer.
5  After restarting, the computer displays a Sys-
tem Configuration message. Check to see if 
Pro Tools performance has increased before you 
deselect the “Don't show this message again” 
option. If performance has not changed, run 
“msconfig” and return your computer Startup 
Selection back to Normal Startup - load all device 
drives and services. Alternatively, try disabling 
Startup items and non-essential processes indi-
vidually.

Optimizing a Mac System for 
Pro Tools
To ensure optimum performance with 
Pro Tools, configure your computer before using 
Pro Tools software.

Before configuring your computer, make sure 
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For 
details on Administrator privileges in Mac OS X, 
see your Apple OS X documentation. 

For Windows System Optimization, see 
“Optimizing a Windows System for 
Pro Tools” on page 56.

Do not use the Mac OS X automatic 
Software Update feature, as it may upgrade 
your system to a version of Mac OS that has 
not yet been qualified for Pro Tools. For 
details on qualified versions of Mac OS, see 
the latest compatibility information on the 
Digidesign website (www.digidesign.com/
compatibility).
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Turning Off Software Update

To turn off the Software Update feature:

1  Choose System Preferences from the Apple 
menu and click Software Update.

2  Click the Software Update tab. 

3  Deselect Check for Updates.

1  Turning Off Energy Saver

To turn off the Energy Saver feature:

1  Choose System Preferences from the Apple 
menu and click Energy Saver.

2  Click the Sleep tab and do the following:

• Set the computer sleep setting to Never.

• Set the display sleep setting to Never.

• Deselect “Put the hard disk(s) to sleep when 
possible” option.

Setting Processor Performance

To set the Processor Performance:

1  Choose System Preferences from the Apple 
menu and click Energy Saver.

2  Click the Options tab and set Processor Perfor-
mance to Highest.
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Disable or Reassign Mac Keyboard 
Shortcuts Used by Pro Tools

To have the full complement of Pro Tools key-
board shortcuts, you need to disable or reassign 
any conflicting Mac OS X Keyboard Shortcuts in 
the Apple System Preferences, including the fol-
lowing:

• “Show Help menu”

• Under “Keyboard Navigation”

• “Move focus to the window drawer”

• Under “Dock, Exposé, and Dashboard”

• “Automatically hide and show the Dock”

• “All windows”

• “Application windows”

• “Desktop”

• “Dashboard”

• “Spaces”

• Under “Spotlight”

• “Show Spotlight search field” 

• “Show Spotlight window”

To disable or reassign Mac OS X keyboard 
shortcuts:

1  Choose System Preferences from the Apple 
menu and click Keyboard & Mouse. 

2  Click the Keyboard Shortcuts tab.

3  Do one of the following:

• Deselect the Mac OS X options that conflict 
with Pro Tools keyboard shortcuts.

– or –

• Assign different, non-conflicting keyboard 
shortcuts to the corresponding Mac OS X 
options.

For a complete list of Pro Tools keyboard 
shortcuts, see the Keyboard Shortcuts Guide 
(Help > Keyboard Shortcuts).



Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign 
the Spaces keyboard shortcuts to avoid conflicts 
with important Pro Tools keyboard shortcuts. 
You can reassign Spaces keyboard shortcuts to 
use a combination of modifier keys (Com-
mand+Option+Control+Shift) in addition to 
the default Spaces keyboard shortcut assign-
ments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use 
modifier key combinations that do not conflict 
with Pro Tools keyboard shortcuts:

1  Choose System Preferences from the Apple 
menu and click Exposé & Spaces. 

2  Click the Spaces tab.

3  Ensure that Enable Spaces is selected.

4  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+F8” from the “To activate Spaces” pop-up 
menu.

5  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Arrow Keys” from the “To switch between 
spaces” pop-up menu.

6  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Number Keys” from the “To switch directly 
to a space” pop-up menu.
Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically 
indexes files and folders on local hard drives in 
the background. In most cases, this is not a con-
cern for normal Pro Tools operation. However, 
if Spotlight starts indexing drives while record-
ing in a Pro Tools session with high track counts 
for an extended period of time, it can adversely 
affect Pro Tools system performance. You may 
want to disable Spotlight indexing for all local 
drives before using Pro Tools for big recording 
projects.

To disable Spotlight indexing:

1  Choose System Preferences from the Apple 
menu and click Spotlight. 

2  In the Spotlight window, click the Privacy tab.

3  To prevent indexing of a drive, drag its icon 
from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, 
enable journaling.

To enable journaling:

1  Launch the Disk Utility application, located in 
Applications/Utilities.

2  Select the volume in the left column of the 
Disk Utility window.

3  Select Enable Journaling in the toolbar.

Disabling Spotlight indexing also disables 
the Find function in Mac OS X. 
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chapter 5

Making Studio Connections
This chapter provides general information on 
connecting Pro Tools to your system, including 
digital equipment, effects units, MIDI gear, and 
SMPTE synchronization devices.

Refer to the 192 I/O Guide, 192 Digital I/O Guide, 
96 I/O Guide, or 96i I/O Guide for specific details 
regarding:

• Front and back panel connectors and indi-
cators

• Installation of optional expansion I/O 
cards (192 I/O only)

Pro Tools|HD audio interfaces need room at 
their sides to maintain proper air flow for 
cooling. Do not block the sides of the unit or 
disconnect the internal fan. If the units are 
rack-mounted in a case, remove the case 
lids or doors before operating the system. 
Failure to do so can result in the units over-
heating very quickly, which can perma-
nently damage sensitive components.
Setting Up Your Studio
Figure 9 on page 64 illustrates a typical studio 
setup, with a 192 I/O connected to a mixing 
console, effects and other equipment.

Figure 10 on page 65 illustrates a setup without 
a mixer, where effects and monitoring gear are 
connected directly to a 96 I/O.
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Example Studio Setup with a Mixing Console
Pro Tools|HD Setup Guide
Figure 9.  Typical studio configuration using a 192 I/O with mixer connections 
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Example Studio Setup without a Mixing Console
Figure 10.  Typical studio configuration using a 96 I/O without a mixer
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192 I/O

The 192 I/O features two DB-25 breakout con-
nectors for two sets of eight inputs each, at 
+4 dBu and –10 dBV respectively. 

There are no –10 dBV outputs, however; analog 
outputs break out from a single DB-25 output at 
+4 dBu operating levels. 

The 192 I/O requires a custom DB-25 snake. 
Digidesign sells several different DigiSnake DB-
25 cables for this purpose. Contact your dealer 
or Digidesign for more information.

192 Digital I/O

The 192 Digital I/O features two DB-25 breakout 
connectors for two sets of eight AES/EBU or 
TDIF inputs and outputs, along with a pair of 
ADAT Optical ports. 

The 192 Digital I/O requires a custom DB-25 
snake. Digidesign sells several different DigiS-
nake (DB-25) cables for this purpose. Contact 
your dealer or Digidesign for more information.

96 I/O

The 96 I/O analog connectors are TRS 1/4-inch 
with TIP wired hot (or “+”), RING cold (or “–”), 
and SLEEVE ground. If connecting to unbal-
anced loads, use unbalanced TS cables.

There is one bank of eight inputs (software-swit-
chable between +4 dBu and –10 dBV line levels 
on a line-by-line basis).

There is one bank of eight outputs (that use 
+4 dBu line levels).

When driving unbalanced lines on the 
192 I/O output card, leave the negative “–” 
terminals disconnected. Failure to do so will 
result in noisy outputs.
Pro Tools|HD Setup Guide
96i I/O

The 96i I/O analog connectors are balanced TRS 
1/4-inch with TIP wired hot (or “+”), RING cold 
(or “–”), and SLEEVE ground. If connecting to 
unbalanced loads, use unbalanced TS cables.

The 96i I/O provides 16 inputs and two outputs. 
Inputs 1–4 feature variable, multi-level input 
sensitivity, controllable from within Pro Tools 
(from –12 dBV to +4 dBu). Inputs 5–16 provide a 
choice of two fixed operating levels (–8 dBV or 
+4 dBu).

Outputs 1–2 are selectable between –10 dBV and 
+4 dBu.

Connecting Equipment with 
Digital Audio Ins and Outs
Each Pro Tools|HD audio interface includes at 
least one AES/EBU, S/PDIF, or Optical (ADAT) 
digital option. For example, the 192 I/O in-
cludes additional AES/EBU and optical ports, as 
well as TDIF, dual-wire AES/EBU at 192 kHz, and 
sample rate converters. The 96i I/O provides two 
channels of S/PDIF only. (See the documenta-
tion for your audio interface for details.) 

The following example provides basic setup 
guidelines for connecting Pro Tools to a DAT re-
corder.

To connect your Pro Tools system to a DAT 
recorder:

1  Connect the AES/EBU or S/PDIF output on the 
enclosure of your Pro Tools|HD audio interface 
to the AES/EBU or S/PDIF input of your DAT 
deck. By default, this port is assigned to Pro 
Tools Output 1–2.



2  Connect the AES/EBU or S/PDIF input on the 
enclosure to the AES/EBU or S/PDIF output of 
your DAT deck. Route the digital input to 
Pro Tools inputs in the Hardware Setup dialog.

Connecting Effects Units
The 192 I/O, 192 Digital I/O and 96 I/O let you 
connect analog or digital effects units to your 
Pro Tools system, and use them as inserts or 
make them the destination for effects sends and 
returns. (The 96i I/O supports a single pair of 
hardware inserts using channels 1–2. See the 
96i I/O Guide for more information.)

Five inserts are available on each audio channel. 
Each insert can be a hardware insert (or software 
plug-in), and can be mono or stereo.

When using a hardware insert, you must con-
nect the device to matching inputs and outputs 
on your system. For example, a stereo insert 
could use outputs 7–8 and inputs 7–8 for the 
sends and returns, respectively. Routing the 
physical inputs and outputs of the interface to 
Pro Tools inputs and outputs can be done in ei-
ther the Hardware Setup dialog or I/O Setup di-
alog. From I/O Setup, inserts can also be defined, 
and their channels mapped to audio interface 
channels (for more information, see the 
Pro Tools Reference Guide).

You can route any of the physical input or 
output pairs to any of the input and output 
channel assignments in the Pro Tools 
mixer. (The 96i I/O does not support input 
mapping, however.) For more information 
see the Pro Tools Reference Guide.
You can also connect effects units to your sys-
tem by using any analog or digital inputs and 
outputs as Auxiliary Inputs and Outputs for ef-
fects sends and returns. Once an effects unit is 
attached this way, you can send a variable 
amount of a track’s output to the effects unit us-
ing a send in Pro Tools. 

Ten separate send controls on each Pro Tools 
track allow you to route audio to any of the 
available outputs connected to your system or 
through any of the 128 internal busses in the 
Pro Tools Mixer. Outputs can be returned to 
Auxiliary Inputs for automated mixing or pro-
cessing.

When you are using an effect in this send and 
return type of configuration, make sure the 
unit’s internal mix or balance between direct 
(unprocessed) and wet (effected) signal is set so 
that only the processed signal is returned to 
Pro Tools. On most effect units, a balance set-
ting of 100% (completely wet) is the appropriate 
setting. 

If you’ve been using an effects unit in an instru-
ment setup, such as a guitar effects rack, you’ll 
probably find the balance to be below 50%. If 
the unit has separate dry and effect level knobs, 
turn dry level control off. If you don’t do this, 
the dry, unprocessed signal will be present in an 
effect’s output along with the desired processed 
sound, and you’ll have trouble accurately con-
trolling the effect balance in your final mix. 
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Connecting Effects Units Digitally

To use your audio interface’s inputs and outputs 
as effects sends and returns to a digital effects 
device, set your interface’s Clock Source to Inter-
nal in the Hardware Setup dialog (unless it is ref-
erenced to another clock source or peripheral). 
You should then set your digital effects devices 
to accept an external digital clock so that they 
will synchronize themselves to Pro Tools. Make 
sure you set the channel pair to the digital input 
in the Hardware Setup dialog (or I/O Setup dia-
log).

Connecting MIDI Devices
By adding a compatible MIDI interface to your 
system, you can take advantage of all the MIDI 
features of Pro Tools, including recording and 
editing MIDI tracks, and synchronizing to MIDI 
Time Code or MIDI beat clock.

USB MIDI interfaces work effectively with 
Pro Tools systems on Windows or Mac. Serial 
MIDI interfaces are supported on Windows sys-
tems only.

Only USB MIDI interfaces are compatible 
with Pro Tools systems on Mac OS X. 
Modem-to-serial port adapters and serial 
MIDI devices are not supported.

See Appendix C, “Configuring MIDI Studio 
Setup (Windows Only)”or Appendix D, 
“Configuring AMS (Mac OS X Only)” for 
detailed information on how to identify ex-
ternal MIDI devices connected to your MIDI 
interface and configure your MIDI studio 
for use with Pro Tools.
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To connect MIDI devices to your system:

1  Connect the MIDI interface to your computer 
according to the MIDI interface’s documenta-
tion.

2  Install any MIDI driver software required by 
the MIDI interface. (Once you have installed 
your MIDI interface hardware and software, 
confirm that it is working properly using the 
procedure given in the interface’s documenta-
tion.)

3  Connect the MIDI OUT of your MIDI device 
to the MIDI IN of your MIDI interface. 

4  Connect the MIDI IN of your MIDI device to 
the MIDI OUT of your MIDI interface. 

Connecting SMPTE 
Synchronization Devices
If you intend to synchronize Pro Tools to exter-
nal devices with SMPTE, your system must be 
connected properly. For details on SMPTE and 
synchronization, see the Pro Tools Reference 
Guide or the SYNC HD Guide.

Digidesign SYNC Peripherals

Digidesign SYNC peripherals provide all the 
functions and connections needed to synchro-
nize to a variety of devices with Pro Tools|HD. 

Digidesign SYNC peripherals support all 
Pro Tools sample rates, and synchronize to most 
major time code and clock reference standards 
used in audio, video, film, and multimedia 
production. 



SYNC peripherals integrate into the Loop Sync 
configuration of a Pro Tools|HD system, offering 
extremely fast lockup, near-sample accurate syn-
chronization, and an exceptionally low-jitter 
clock. These features provide professional per-
formance and maximum audio fidelity under a 
wide range of synchronization conditions.

Connecting Ethernet Control 
Surfaces
If you are using a built-in Ethernet port or a PCI 
or PCIe Ethernet card to connect your computer 
directly (rather than across a network) to a 
D-Control®, D-Command®, ProControl™, 
C|24™, or Control|24™, the TCP/IP address must 
be set manually. The default manual settings 
will work in most cases. Do not use DHCP unless 
your computer is connected to a network that 
provides DHCP services.

For more information, refer to the SYNC HD 
Guide.
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appendix a

Connecting SCSI Drives
SCSI hard drives are supported recording media 
for Pro Tools|HD systems on Windows and Mac.

Although Pro Tools will let you record to your 
system drive, this is generally not recom-
mended. Performance for recording and play-
back on system drives is sometimes worse than 
on non-system drives, resulting in lower track 
counts and fewer plug-ins. 

For the most current information on hard drive 
requirements and recommendations, visit the 
Digidesign website (www.digidesign.com). 

Be aware that recording to your system 
drive can quickly use up available hard 
drive space. This can negatively affect 
system stability and the performance of 
all applications including Pro Tools.
SCSI Requirements
Digidesign recommends qualified SCSI hard 
drives and a qualified SCSI host bus adapter 
(HBA) card or (on Windows systems) a qualified 
built-in SCSI HBA connector on the mother-
board.

For a list of qualified SCSI hard drives and SCSI 
HBA cards, visit the Digidesign website 
(www.digidesign.com).

Software RAID is not supported for audio 
drives.
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SCSI Cables

Use shorter SCSI cables to improve reliability. 
Table 1 provides guidelines for maximum cable 
lengths according to SCSI type.

In the following table, the maximum cable 
length includes all cables used in the chain, not 
just point-to-point connections.

Table 1: Maximum cable length and number of drives 
supported according to SCSI type

SCSI Type and 
Transfer Rate

Maximum 
Cable Length

Maximum 
Number of 
Drives

Fast SCSI
10 MB/sec

3 meters 8

Wide SCSI
20 MB/sec

3 meters 16

Ultra SCSI
20 MB/sec
(8-bit narrow)

3 meters 5

Ultra SCSI
40 MB/sec
(16-bit wide)

3 meters 5

Ultra SCSI
20 MB/sec
(8-bit narrow)

1.5 meters 6–8

Ultra SCSI
40 MB/sec
(16-bit wide)

1.5 meters 6–8

Ultra1 SCSI
Low Voltage 
Differential (LVD)
160 MB/sec

12 meters 16

Ultra2 SCSI
Low Voltage 
Differential (LVD)
80 MB/sec

12 meters 16

Ultra3 SCSI
Low Voltage 
Differential (LVD)
320 MB/sec

12 meters 16
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Distribute Audio Across Multiple Drives

For best recording and playback performance, 
don’t record and play back all audio files in a ses-
sion from the same drive. Instead, use Pro Tools 
Disk Allocation features to distribute audio files 
between multiple drives. See the Pro Tools Refer-
ence Guide for details.

Separate Video and Audio Files

If you are working with QuickTime, movie files 
must reside on a different SCSI bus than audio 
files. If audio files reside on disks connected to a 
SCSI HBA card, video data should reside on 
drives connected to a different SCSI bus.

Dual-Channel SCSI HBA Cards

If you use a dual-channel SCSI HBA card, allo-
cate audio files equally to drives connected to 
each of the two busses on the card for optimal 
performance.

If using video files, make sure to put your video 
files on one bus and audio files on the other bus.

Connecting SCSI Drives

To connect an external SCSI drive:

1  Turn off power to both the computer and the 
hard drive.

2  Attach a SCSI cable from the SCSI port of the 
hard drive to the SCSI port of the SCSI HBA card 
or computer.

3  Secure the cable’s connectors to the hard drive 
and computer.

4  Connect additional drives by daisy-chaining 
from one drive to another. Keep cable lengths to 
a minimum (see Table 1).



5  Verify that the last SCSI device in the chain is 
properly terminated. (See “SCSI Termination” 
on page 73.)

6  Make sure each SCSI device has a unique ID.

7  Attach power cables to the hard drives.

SCSI ID 7 is reserved for the host computer. 
Do not use ID 7 with any of your SCSI de-
vices.

Connecting a SCSI cable to a SCSI HBA card

Connecting an external SCSI hard drive

SCSI HBA Card

To SCSI Drive

to SCSI accelerator card
SCSI Termination

Your computer’s SCSI chain must be properly 
terminated or your system will not function cor-
rectly. Only the last device on the chain should 
be terminated using the termination type rec-
ommended by the hard drive manufacturer. 

The drive should use either an external termina-
tor plug or have its internal terminators en-
abled. If you are using a terminator plug, Digide-
sign recommends that you purchase and use an 
active terminator.

Do not enable internal termination and in-
stall an external terminator plug on the 
same drive. This will cause SCSI errors. See 
your hard drive’s documentation for infor-
mation on which type of termination it 
uses. 
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appendix b

Hard Drive Configuration and Maintenance
It is recommended that you start with a newly 
formatted external or secondary internal audio 
drive. You should also periodically defragment 
your audio drive to ensure continued system 
performance.

Avoid Recording to the 
System Drive
Recording to your system drive is not recom-
mended. Recording and playback on a system 
drive may result in lower track counts or fewer 
plug-ins.

Always back up any important data on your 
drive before formatting it, as it will erase all 
data on the drive.
Supported Drive Formats and 
Drive Types

Drive Formats

Windows Windows systems should use drives 
formatted as NTFS only. 

Mac Mac systems should use drives formatted 
with HFS or HFS+ file system only.

Hard drive performance depends on factors in-
cluding system configuration, number of tracks, 
session sample rate, density of edits, and the use 
of crossfades and other processes such as Beat 
Detective in a session. 

For complete hard drive requirements, see the 
Digidesign website (www.digidesign.com/
compatibility).

Windows systems can also support Mac 
drives formatted using the HFS+ system 
(also commonly referred to as Mac OS Ex-
tended). Refer to the Pro Tools Reference 
Guide for more information.

HFS drives are supported as Transfer drives 
only.
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SCSI Hard Drives

Digidesign recommends qualified SCSI hard 
drives and a qualified SCSI host bus adapter 
(HBA) card or (on Windows systems) a qualified 
built-in SCSI HBA connector on the mother-
board.

For complete information on track count and 
the supported number and configuration of 
SCSI drives, visit the Digidesign website 
(www.digidesign.com/compatibility).

FireWire Hard Drives

Digidesign recommends qualified FireWire 
drives for all systems. On systems without Fire 
Wire ports, a Digidesign-qualified FireWire host 
adapter is recommended.

For complete information on track count and 
the supported number and configuration of 
FireWire drives, visit the Digidesign website 
(www.digidesign.com).

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be 
used as a dedicated audio drive. 

For complete information on track count with 
internal drives, refer to the Digidesign website 
(www.digidesign.com).

For more information, see Appendix A, 
“Connecting SCSI Drives.”

IDE/ATA/SATA hard drives provide limited 
track count performance and are not sup-
ported when an Expansion Chassis is used. 
For more information regarding Expansion 
Chassis operating procedures, see the 
Pro Tools Expanded Systems Guide.
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Formatting an Audio Drive

Formatting Windows Audio Drives

For optimal performance, audio drives should 
be formatted as NTFS.

To format an audio drive:

1  Right-click My Computer (Windows XP) or Com-
puter (Windows Vista) and choose Manage. 

2  Under Storage, choose Disk Management.

3  If the volume is “Healthy,” do the following:

• In the Disk Management window, right-
click the hard drive you will use for audio 
and choose Format.

• In the Format window, name the volume.

• Choose a file system. For optimum perfor-
mance, audio drives should be formatted as 
NTFS.

• Select “Perform a quick format.”

• Make sure “Enable file and folder compres-
sion” is not selected.

• Set the Allocation unit size to Default.

• Click OK.

Disk Management window

Healthy volumes are volumes that have pre-
viously been partitioned and formatted.



4  If the volume is “Unallocated,” do the follow-
ing:

• In the Disk Management window, right-
click the hard drive you will use for audio 
and choose New Partition.

• In the New Partition Wizard window, click 
Next.

• When prompted, select the partition type.

• Follow the on-screen instructions to select 
a partition size and other partition settings.

• When prompted, choose a file system. For 
optimum performance, audio drives 
should be formatted as NTFS.

• Select “Perform a quick format.”

• Make sure “Enable file and folder compres-
sion” is not selected.

• Set the Allocation unit size to Default.

• Click OK.

Pro Tools only supports Basic drive types. 
Do not convert the drive to a Dynamic type. 

Digidesign recommends using Primary par-
titions, instead of Extended partitions.

Pro Tools only supports Basic drive types. 
Do not convert the drive to a Dynamic type. 
Formatting Mac Audio Drives

For optimum performance, audio drives should 
be formatted as Mac OS Extended (Journaled). 

To format an audio drive: 

1  Launch the Disk Utility application, located in 
Applications/Utilities.

2  Click the Erase tab. 

3  Select the drive you want to initialize in the 
column on the left side of the window. 

4  Choose Mac OS Extended (Journaled). 

5  Type a name for the new volume. 

6  If you plan to connect the drive to a Mac OS 9 
computer, select Install Mac OS 9 Drivers. 

7  Click Erase.

The drive appears on the Desktop with the new 
volume name.

Disk Utility (Mac OS X)

Do not choose the “Case-Sensitive” format 
option. Pro Tools will not operate properly 
with case-sensitive formatted drives.
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Partitioning Drives
Partitioning creates a logical volume or volumes 
on a physical drive, almost as if you were creat-
ing virtual hard drives. Partitions can then be 
formatted with the appropriate file system 
(NTFS for Windows, HFS+ for Mac). 

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned 
drives (assuming that reads and writes are per-
formed on a single partition), since the heads 
only have to seek within the partition bound-
aries, rather than the whole capacity of the 
drive.

Smaller partitions perform faster than larger par-
titions, but this comes at the expense of contig-
uous storage space. When you partition a drive, 
you will need to find the compromise that best 
suits your performance and storage require-
ments. 

The NTFS file system allows drives to be 
seen as whole volumes. Single Pro Tools au-
dio files cannot exceed 3.4 GB in size.

Mac OS allows drives larger than 4096 MB 
to be seen as whole volumes. Drives must be 
initialized with a disk utility that recog-
nizes the 2 terabyte limit. Single Pro Tools 
audio files cannot exceed 3.4 GB in size.

Avoid distributing audio files within a ses-
sion over different partitions on the same 
drive since this will adversely affect drive 
performance.
Pro Tools|HD Setup Guide
Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), 
you can limit fragmentation by backing up your 
important files to another disk, erasing the files 
from the original hard disk, then copying the 
files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain 
system performance. 

For maximum recording and playback effi-
ciency, data should be written to your hard 
drive in a contiguous fashion—minimizing the 
seek requirements to play back the data. Unfor-
tunately, your computer can’t always store the 
sound files in this way and must write to disk 
wherever it can find space.

In multitrack recording, audio tracks are written 
in discrete files, spaced evenly across the disk. 
While fragmentation of individual files may be 
zero, the tracks may be far enough apart that 
playback will still be very seek-intensive. Also, 
the remaining free space on the disk will be dis-
contiguous, increasing the likelihood of file 
fragmentation on subsequent record passes.

Increased fragmentation increases the chance of 
disk errors, which can interfere with playback of 
audio, and result in performance errors.

On Windows, to avoid fragmentation, for-
mat drives with higher cluster sizes (such as 
32K).



Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize 
your drive, which rearranges your files into a 
contiguous format. Most optimizing software 
lets you run a check on a drive to find out the 
percentage of fragmentation. If your drive 
shows moderate to heavy fragmentation, you 
should consider optimizing it.

If you use your system for intensive editing, or if 
you frequently delete audio or fade files from 
your hard drive, you may need to optimize your 
drives on a weekly basis, or even every few days, 
since it doesn’t take long for even a large hard 
drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimi-
zation process, always make a backup copy of 
the data on your hard drive before you optimize 
it. You should also use a hard drive utility to find 
and repair any problems before optimizing data 
or re-initializing your drives. If there is any dam-
age to your hard drive's directories prior to opti-
mizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive:

1  Right-click My Computer (Windows XP) or 
Computer (Windows Vista) and choose Manage.

2  Under Storage, choose Disk Defragmenter.

3  In the Disk Defragmenter window, choose the 
drive you want to defragment

4  Click the Defragment button and follow the 
on-screen instructions.

When defragmenting is complete, close the 
Computer Management window.
Using Mac Drives on Windows 
Systems
Pro Tools for Windows lets you record and play 
back sessions directly from a Mac-formatted 
(HFS+) drive connected to a Windows system. 
This functionality requires that all Mac session 
and audio files be stored on Mac-formatted 
drives.

During Pro Tools installation, make sure to se-
lect the Mac HFS+ Disk Support option. This op-
tion lets your Pro Tools system read, write, 
record, and play back using Mac-formatted HFS+ 
disks.

Formatting and Maintaining HFS+ 
Drives

To format and partition any drives as HFS+, con-
nect the drives to a Mac computer and use the 
Apple OS X Disk Utility. 

For information on sharing sessions be-
tween Mac and Windows systems, see the 
Pro Tools Reference Guide.
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Hard Disk Storage Space
Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 
5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 
7.5 MB per minute. 

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 
10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 
15 MB per minute.

Table 3 lists the required disk space for certain track numbers and track lengths, to help you estimate 
your hard disk usage.
Table 3. Required hard drive space for audio tracks (44.1 
Pro Tools|HD Setup Guide
kHz and 48 kHz sessions shown)
Number of Tracks and Length 16-bit at 
44.1 kHz

16-bit at 
48 kHz

24-bit at 
44.1 kHz

24-bit at 
48 kHz

1 mono track, 1 minute 5 MB 5.5 MB 7.5 MB 8.2 MB

1 stereo track (or two mono 
tracks), 5 minutes

50 MB 55 MB 75 MB 83 MB

1 stereo track (or two mono 
tracks), 60 minutes

600 MB 662 MB 900 MB 991 MB

24 mono tracks, 5 minutes 600 MB 662 MB 900 MB 991 MB

24 mono tracks, 60 minutes 7 GB 7.8 GB 10.5 GB 11.6 GB

32 mono tracks, 5 minutes 800 MB 883 MB 1.2 GB 1.3 GB

32 mono tracks, 60 minutes 9.4 GB 10.4 GB 14 GB 15.4 GB



appendix c

Configuring MIDI Studio Setup 
(Windows Only)
MIDI Studio Setup
MIDI Studio Setup (MSS) lets you configure the 
MIDI controllers and sound modules that are 
connected to your system, and control the rout-
ing of MIDI data between your MIDI equipment 
and Pro Tools.

MSS automatically finds MIDI interfaces, and 
lets you specify a custom name for each of the 
MIDI ports within the MIDI Studio Setup docu-
ment. 

MSS also supports XML-based patch file names 
for storing and importing patch names for your 
external MIDI devices. 

Entire MIDI Studio Setup configurations created 
within MSS can be imported and exported. 
Ap
MIDI Studio Setup Window

The MIDI Studio Setup window is organized 
into three sections. Interface controls are at the 
top of the window. All the currently defined in-
struments are displayed in the Instrument Name 
list on the left side of the window. A detailed 
view of MIDI parameters is shown in the Proper-
ties section on the right.

MIDI Studio Setup window
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Interface Controls

Create Adds a new instrument to the Instru-
ment Name list.

Delete Deletes the instrument or instruments 
selected in the Instrument Name list.

Import Imports an existing MIDI Studio Setup 
file.

Export Exports the current MIDI Studio Setup 
file.

Show Duplicate Emulated Ports When this op-
tion is selected and you are using a MIDI inter-
face that supports timestamping (such as MIDI 
I/O), in addition to the MIDI ports on Mbox 2, 
the MIDI Studio setup window shows both the 
DirectMusic time-stamped output ports, and 
non-stamped duplicate emulated output ports. 

Instrument List

The Instrument list contains all the currently 
defined instruments. Selecting an instrument in 
the list displays that instrument’s properties in 
the Properties section of the window.

Some MIDI Interfaces will not properly load 
or unload their drivers unless you quit and 
re-launch Pro Tools. Check the documenta-
tion that came with your MIDI interface for 
more information.
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Properties Section

The Properties section lets you edit information 
for new instruments, or instrument currently se-
lected in the Instrument list.

When a previously defined instrument is se-
lected in the Instrument list, the Properties sec-
tion changes to reflect the properties of the se-
lected instrument.

To define an instrument with MIDI Studio Setup:

1  Choose Setup > MIDI > MIDI Studio.

2  Click Create.

3  In the Instrument Name field, type the name 
of your instrument, and press Enter.

4  Set a manufacturer and model for the new de-
vice from the corresponding pop-up menus. If 
the Manufacturer and Model pop-up menus do 
not provide a name for your particular device, 
choose None.

5  From the Input pop-up menu, choose the in-
put port on your MIDI interface that is con-
nected to the MIDI Out of your instrument.

MIDI Studio Setup Properties section

If you do not enter an instrument name, the 
Instrument Name field will automatically 
inherit information from the Manufacturer 
and Model pop-up menu. 



6  From the Output pop-up menu, choose the 
output port on your MIDI interface that is con-
nected to the MIDI In of your instrument.

7  Enable the appropriate MIDI channels (1–16) 
for the Send Channels and Receive Channels 
options (These determine which channels send 
and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-de-
finable instrument name for the currently se-
lected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list 
of MIDI equipment manufacturers. This list is 
derived from the XML-based MIDI device files. 

Model

The Model pop-up menu provides a list of MIDI 
devices, filtered by the manufacturer name. This 
list is derived from the XML-based MIDI device 
files provided with your Pro Tools installation.

Input Port

The Input Port pop-up menu displays a list of 
available MIDI interface input ports. The MIDI 
interface port that is set and displayed here is 
the port through which MIDI data is sent from 
the external MIDI device specified in the Instru-
ment Name field into your MIDI interface.

For more information, see “MIDI Patch 
Name Support” on page 83.

For more information, see “MIDI Patch 
Name Support” on page 83.

If you set the input port to None, the defined 
instrument will not appear as a choice in a 
MIDI Input Selector. 
Ap
Output Port

The Output Port pop-up menu displays a list of 
available MIDI interface output ports. The port 
set and displayed here is the port through which 
MIDI data is sent from your MIDI interface to 
the MIDI device specified in the Instrument 
Name field.

Send Channels

The Send Channels grid sets the send channels 
for the MIDI device specified in the Instrument 
Name field. 

Receive Channels

The Receive Channels grid sets the receive chan-
nels for the MIDI device specified in the Instru-
ment Name field.

MIDI Patch Name Support
Pro Tools supports XML (Extensible Markup 
Language) for storing and importing patch 
names for your external MIDI devices. Pro Tools 
installs MIDI patch name files (.midnam) for the 
factory default patch names of many common 
MIDI devices. These files reside in directories, 
sorted by manufacturer, in Program Files\ 
Common Files\Digidesign\MIDI Patch Names\ 
Digidesign.

To import MIDI patch names into Pro Tools:

1  Verify the MIDI Device name in the MIDI Stu-
dio Setup window (see “MIDI Studio Setup” on 
page 81).

2  Verify the Instrument or MIDI track output is 
correctly assigned to the MIDI device.

If you set the output port to None, the de-
fined instrument will not appear as a choice 
in a MIDI Output Selector. 
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3  Click the Instrument or MIDI track Patch Se-
lect button.

4  In the Patch Select dialog, click Change.

5  In the Open dialog, navigate to Program 
Files\Common Files\Digidesign\MIDI Patch 
Names\Digidesign\<name of manufacturer>, 
and select the MIDI Patch Name file (.midnam) 
for the MIDI device.

6  Click Open.

Patch Select button, Edit window

Patch Select button, Mix window

Patch Select dialog

Patch Select button

Patch Select button

Change button
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The Patch Select dialog is populated with patch 
names and the Patch Name Bank pop-up menu 
appears in the upper left hand corner of the win-
dow.

Once patch names have been imported into 
Pro Tools, they are available for that MIDI de-
vice in all sessions.

To clear patch names:

� In the Patch Select dialog, click Clear, and 
then click Done.

Patch Select dialog with patch names

MIDI patch name files (.midnam) can be 
edited in any text editor, or you can use 
third-party patch librarian and editor soft-
ware to create your own custom patch 
names.



appendix d

Configuring AMS (Mac OS X Only)
Audio MIDI Setup
Pro Tools recognizes the ports on your MIDI in-
terface as generic ports. With Mac OS X, you use 
Apple’s Audio MIDI Setup (AMS) utility to iden-
tify external MIDI devices connected to your 
MIDI interface and configure your MIDI studio 
for use with Pro Tools.

To configure your MIDI studio in AMS:

1  Do one of the following:

• Launch Audio MIDI Setup (located in Ap-
plications/Utilities).

– or –

• In Pro Tools, choose Setup > MIDI > MIDI 
Studio.

To ensure optimum performance, do not 
change the AMS configuration while 
Pro Tools is playing back. Stop the 
Pro Tools transport before launching AMS. 
2  Click the MIDI Devices tab. AMS scans your 
system for connected MIDI interfaces. If your 
MIDI interface is properly connected, it appears 
in the window with each of its ports numbered.

3  For any MIDI devices connected to the MIDI 
interface, click Add Device. A new external de-
vice icon with the default MIDI keyboard image 
will appear.

4  Drag the new device icon to a convenient lo-
cation within the window.

Audio MIDI Setup (MIDI Devices tab)
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5  Connect the MIDI device to the MIDI inter-
face by clicking the arrow for the appropriate 
output port of the device and dragging a con-
nection or “cable” to the input arrow of the cor-
responding port of the MIDI interface.

6  Click the arrow for the appropriate input port 
of the device and drag a cable to the output ar-
row of the corresponding port of the MIDI inter-
face. 

7  Repeat steps 3–6 for each MIDI device in your 
MIDI setup.

Making MIDI input and output connections

To remove a connection, select the cable and 
press Delete.
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To configure an external MIDI device:

1  Select the external device icon and click Show 
Info (or double-click the new device icon). 

2  Select a manufacturer and model for the new 
device from the corresponding pop-up menus. 
(If the Manufacturer and Model pop-up menus 
do not provide a name for your particular de-
vice, you can type a name.)

External Device Icon

Naming a new MIDI device

 For Manufacturer and Model names, AMS 
refers to one or more files with the suffix 
“.middev” in the directory Root/Library/
Audio/MIDI Devices. Pro Tools installs a 
file that contains information for many 
commercially available MIDI devices, 
named “Digidesign Device List.middev.” If 
the Manufacturer or Model names for any of 
your external MIDI devices is not available 
in the AMS Manufacturer and Model pop-up 
menus, you can add them by editing the 
.middev file in any text editor (such as 
TextEdit). 



3  Click the More Information arrow to expand 
the dialog, then enable the appropriate MIDI 
channels (1–16) for the Transmits and Receives 
options. (These determine which channels the 
device will use to send and receive MIDI.) 

Enabling MIDI channels
4  Click the device image. The window expands 
to show images for various MIDI devices (such 
as keyboards, modules, interfaces, and mixers). 
Select an icon for your device. 

5  Select a device image and click Apply. 

6  Close the AMS window to quit the AMS appli-
cation. 

The device names you enter appear as MIDI in-
put and output choices in Pro Tools.

Selecting a device icon

To use your own custom icons, you can 
place TIFF image files in /Library/
Audio/MIDI Devices/Generic/Images, and 
they will appear as choices in the AMS
device window.
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MIDI Patch Name Support
Pro Tools supports XML (Extensible Markup 
Language) for storing and importing patch 
names for you external MIDI devices. Pro Tools 
installs MIDI patch name files (.midnam) for the 
factory default patch names of many common 
MIDI devices. These files reside in directories, 
sorted by manufacturer, in /Library/Audio/MIDI 
Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:

1  Verify the MIDI Device name in the Audio 
MIDI Setup window (see “Audio MIDI Setup” on 
page 85).

2  Verify the Instrument or MIDI track output is 
correctly assigned to the MIDI device.

3  Click the Instrument or MIDI track Patch Se-
lect button.

Patch Select button, Edit window

Patch Select button, Mix window

Patch Select button

Patch Select button
Pro Tools|HD Setup Guide
4  In the Patch Select dialog, click Change.

5  In the Open dialog, navigate to /Library/Au-
dio/MIDI Patch Names/Digidesign/<name of 
manufacturer>, and select the MIDI Patch Name 
file (.midnam) for the MIDI device.

6  Click Open.

The Patch Select dialog is populated with patch 
names and the Patch Name Bank pop-up menu 
appears in the upper left hand corner of the win-
dow.

Once patch names have been imported into 
Pro Tools, they are available for that MIDI de-
vice in all sessions.

To clear patch names:

� In the Patch Select dialog, click Clear, and the 
click Done.

Patch Select dialog

MIDI patch name files (.midnam) can be 
edited in any text editor, or you can use 
third-party patch librarian and editor soft-
ware to create your own custom patch 
names.

Change button



appendix e

DSP-Induced Delays in Mixing
This appendix provides an overview of DSP-in-
duced mixer delays, and explains how you can 
compensate for these delays to improve time 
and phase alignment of audio in complex or 
critical mixing situations. 

• To learn about DSP-induced delays and when 
you should compensate, see “Introduction to 
DSP-Induced Delay” on page 89. 

• To learn how to compensate for delays auto-
matically with Delay Compensation 
(Pro Tools HD only), see “Using Delay Com-
pensation” on page 90.

• For details on the sources of DSP-induced de-
lay, see “Delay Factors” on page 96. 

Introduction to DSP-Induced 
Delay
In all digital systems, DSP processing causes sig-
nal delays of varying amounts. These DSP-in-
duced delays can vary from as short as several 
microseconds to as long as several milliseconds, 
depending on the type of processing or routing 
being performed. 

Do not confuse signal processing-induced 
delays with monitoring latency or time do-
main effects processing (such as delay, echo, 
reverb, and other desirable delay effects).
Each plug-in, hardware insert, and mixer assign-
ment on a track delays that track by an amount 
equal to the total of all DSP-delay factors. (For 
more information on these delays, see “Delay 
Factors” on page 96.)

In some cases, signal processing delays matter 
only if you use a real-time TDM plug-in on one 
channel of a stereo or multichannel signal but 
not the others. This imparts an unequal amount 
of delay to the signals on that channel, which 
subsequently may cause undesirable cancella-
tion of certain frequencies. 

In simple terms, DSP-induced delay can cause 
audio to arrive at the main output (or a submix 
output) at different times. To maintain time 
alignment, you can compensate for DSP-induced 
delays. 

When to Compensate

You may only really need to compensate for de-
lays between tracks where phase coherency 
must be maintained (as with instruments re-
corded with multiple microphones or stereo 
pairs). If you are working with mono signals, 
and the accumulated delays are small (just a few 
samples, for example), you probably do not 
need to worry about compensating for delays.

Audible symptoms of phase issues include 
comb-filtering and loss of high frequencies. 
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However, larger sessions with higher track and 
voice counts, many plug-ins, and/or complex 
mixer routing can benefit when DSP-induced 
delays are compensated to maintain phase co-
herent time alignment. 

In any session, if you want to maintain absolute 
time alignment across all tracks you should al-
ways compensate for signal processing delays. 

Delay Compensation should be enabled during 
playback and mixing so that all tracks’ outputs 
are correctly time-aligned.

When recording, Delay Compensation should 
usually be turned off (see “Low Latency Moni-
toring During Recording” on page 93). 

Using Delay Compensation
Pro Tools provides automatic Delay Compensa-
tion for managing DSP delays from plug-in and 
hardware inserts, and mixer routing (bussing 
and sends). With Delay Compensation enabled, 
Pro Tools maintains phase coherent time align-
ment between tracks that have plug-ins with dif-
fering DSP delays, tracks with different mixing 
paths, tracks that are split off and recombined 
within the mixer, and tracks with hardware in-
serts.

To maintain phase coherent time alignment, 
Delay Compensation should always be enabled 
during playback and mixing. Delay Compensa-
tion should also be used in most recording situ-
ations.

Enabling Delay Compensation

To enable Delay Compensation:

� Select Options > Delay Compensation.
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When Delay Compensation is enabled, the De-
lay Compensation status indicator in the Edit 
Window Toolbar is displayed.

If desired, the Delay Compensation View for 
tracks can be displayed in the Mix Window (see 
“Delay Compensation View” on page 91).

Configuring Delay Compensation 
Engine

The amount of Delay Compensation available 
for your session is set in the Playback Engine. 
The total amount of delay due to inserts and 
mixer routing for the entire session is displayed 
in the Session Setup window.

There are three settings in the Playback Engine 
dialog to dedicate DSP resources for Delay Com-
pensation:

None Allocates no DSP resources for Delay Com-
pensation.

Short Allocates minimum DSP resources of De-
lay Compensation for each channel. This is the 
most efficient setting for Pro Tools|HD Accel 
systems. For sessions with only a few plug-ins 
that do not induce too much DSP-based delay, 
this setting should be sufficient.

Long Allocates maximum DSP resources for De-
lay Compensation for each mixer channel. For 
sessions with a lot of plug-ins resulting in a large 
amount of DSP-induced delay, select this set-
ting.

Delay Compensation indicator



To configure the Delay Compensation Engine:

1  Choose Setup > Playback Engine.

2  From the Delay Compensation Engine pop-up 
menu, select a Delay Compensation setting.

3  Click OK.

Delay Compensation Time Mode

Delay values can be specified in either samples 
or milliseconds, as selected with the Delay Com-
pensation Time Mode setting in the Operation 
Preferences page. 

Delay Compensation Limit

The Delay Compensation limit is displayed in 
samples in the Delay Compensation Engine 
pop-up menu in the Playback Engine dialog. 
This is the maximum amount of Delay Compen-
sation available for the session. This value is dif-
ferent depending on the session sample rate and 
which Delay Compensation Engine option is se-
lected.

System Delay

Pro Tools adds the exact amount of delay to 
each track necessary to make that particular 
track’s delay equal to the total System Delay. 
The total system delay is the longest delay re-
ported on a track, plus any additional delay 
caused by mixer routing.

The System Delay is shown in the Session Setup 
window (Session > Setup). Reference the re-
ported System Delay to monitor whether or not 
you are close to exceeding the Delay Compensa-
tion limit.
Delay Compensation View

The Delay Compensation View displays the to-
tal amount of plug-in (TDM and RTAS) and 
hardware insert delay on each track, lets you ap-
ply a user offset of track delay, and displays the 
total amount of delay that Pro Tools applies to 
each track. The Delay Compensation View can 
be shown or hidden in the Mix Window.

To view Delay Compensation information: 

� Select View > Mix Window > Delay Compensa-
tion.

System Delay in Session Setup window

Delay Compensation View

Delay Compensation view only shows the 
insert delay for each track. To view the com-
plete system delay, including mixer delays, 
see System Delay in the Session Setup win-
dow (see “System Delay” on page 91).

System Delay

Track
Compensation 

Delay indicator
User Offset field

indicator 
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Delay Compensation View Indicators 
and Field

Delay (dly) Indicator

The Delay (dly) indicator reports the total plug-
in (TDM and RTAS) and hardware insert delay 
on the track. 

The Delay indicator’s report to Pro Tools Delay 
Compensation Engine can be bypassed when 
Delay Compensation is enabled. This is useful 
for manually time-aligning a track when the to-
tal delay on a track exceeds the Delay Compen-
sation limit. See “Delay that Exceeds the Com-
pensation Limit” on page 93.

The display color indicates reported track delay, 
as follows:

Green Indicates that track delay reporting is en-
abled and the track does not exceed the avail-
able amount of Delay Compensation.

Orange Indicates that this is the track reporting 
the longest plug-in and hardware insert delay in 
the session. 

Red Indicates that the amount of plug-in and 
hardware insert delay on the track exceeds the 
available amount of Delay Compensation (see 
“Delay that Exceeds the Compensation Limit” 
on page 93). 

Gray Track delay report is bypassed.
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User Offset (+/–) Field 

This field lets you adjust track delays manually 
while Delay Compensation is enabled. The User 
Offset is in addition to or subtraction from the 
amount of delay applied by Track Compensa-
tion. The User Offset is useful for the following 
cases:

• For manually time-aligning a track if a 
plug-in is incorrectly reporting its delay.

• For adjusting the timing “feel” of a track.

The color of the values in this field indicate User 
Offset status, as follows:

White Indicates that the User Offset is enabled 
on the track and the User Offset compensation 
value is applied to the track.

Gray Indicates that the User Offset is disabled on 
the track and the User Offset compensation 
value is not applied.

To change track delay using the User Offset field:

1  In the Delay Compensation View, click in the 
User Offset edit field.

2  To set your delay value (in samples or millisec-
onds depending on your current preferences), 
do one of the following:

• Enter a positive number (with or without 
the “+” modifier) for a positive delay (later 
in time) or negative number (with the “–” 
modifier) for a negative delay (earlier in 
time). 

• Drag in the User Offset field to scroll to a 
new value. For finer resolution, Control-
drag (Windows) or Command-drag (Mac).

• Press the Up and Down Arrow keys to in-
crease or decrease the numerical values. 

3  Press Enter.



To bypass the user delay:

� Start-Control-click (Windows) or Command-
Control-click (Mac) the User Offset field. The 
user-defined delay appears grayed out and does 
not apply to the track.

Track Compensation (cmp) Indicator 

This indicator shows the amount of Delay Com-
pensation Pro Tools applies to each track. 

The display color indicates the amount of Delay 
Compensation applied, as follows:

Green Track compensation is enabled and the 
track does not exceed the Delay Compensation 
limit. The amount of Delay Compensation 
shown in the indicator is applied to the track.

Blue (Audio Tracks Only) Indicates that Delay 
Compensation is force-enabled on the track. 
When the track is record-enabled or TrackInput-
enabled, Delay Compensation is not suspended 
and remains enabled (see “Overriding Sus-
pended Delay Compensation” on page 94).

Red Indicates that the track delay exceeds the 
available amount of Delay Compensation and 
no Delay Compensation is applied to the track 
(see “Delay that Exceeds the Compensation 
Limit” on page 93). 

Gray Indicates that Delay Compensation for the 
track is bypassed and no delay is applied to the 
track.

Delay that Exceeds the Compensation 
Limit

When the total delay on a track exceeds the to-
tal available amount of available Delay Com-
pensation (selected in the Playback Engine dia-
log), no Delay Compensation is applied on that 
track. Any audio on that track will no longer be 
properly time-aligned and will be out of phase. 
Both the Delay indicator and Track Compensa-
tion indicator turn red to show that the track de-
lay exceeds the Delay Compensation limit. The 
maximum available Delay Compensation is ap-
plied to all other tracks. 

However, you can manually compensate for de-
lay on tracks that exceeds the Delay Compensa-
tion limit.

To compensate for delay that exceeds the 
compensation limit, do one of the following:

� If the Delay Compensation Engine setting in 
the Playback Engine is set to Short, change the 
setting to Long.

– or –

� If the Delay Compensation Engine is already 
set to Long, do the following:

• Bypass the reported delay for the track by 
Start-Control-clicking (Windows) or Com-
mand-Control-clicking (Mac) the Delay in-
dicator. The track information is grayed out 
once it is bypassed.

– and –

• Manually nudge any audio data on the 
track earlier by the amount of delay re-
ported in the track’s Delay indicator.

Low Latency Monitoring During 
Recording

When an audio track is armed for recording 
(record-enabled), TrackInput-enabled, Destruc-
tivePunch-enabled, or punched in, the track’s 
Delay Compensation is automatically sus-
pended (and the Track Compensation indicator 
displays 0). This provides low-latency monitor-
ing on those track outputs.
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Tracks that are not record enabled still apply De-
lay Compensation. Pro Tools automatically 
compensates for any timing discrepancies be-
tween the recorded material and the delay-com-
pensated mix. When the track is played back 
(with both record-enable and TrackInput dis-
abled) it is correctly time-aligned with the other 
delay-compensated tracks.

Overriding Suspended Delay Compensation

You can override the automatic suspension of 
Delay Compensation on record-enabled tracks, 
but you may introduce latency in the signal 
path by the amount of Delay Compensation. 
This latency may be acceptable depending on 
the recording source. 

To apply Delay Compensation to tracks where 
Delay Compensation was suspended:

� Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator. Track delay is applied to the track and 
the Track Compensation indicator displays in 
blue. 

Delay Compensation on Auxiliary 
Inputs

Delay Compensation on Auxiliary Inputs can be 
bypassed to let you monitor outside sources 
(such as the audio tracks of a slaved video deck) 
with minimal latency, while still reporting the 
track’s delay.

In certain dubbing workflows you may want 
to cascade bus recordings to multiple tracks. 
In these cases you should be sure to override 
the automatic suspension of Delay Com-
pensation on the recording tracks.
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To bypass an Auxiliary Input’s Delay 
Compensation:

� Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator. The reported track delay will be zero, 
and will appear grayed out.

Delay Compensation for MIDI

When Delay Compensation is active, a MIDI 
event that is recorded to sound “in time” with 
delay-compensated material actually is recorded 
late by the length of total delay in effect. 

To compensate, MIDI events are shifted back in 
time by the total session delay following each 
MIDI recording pass. 

Low-Latency Recording with Virtual 
MIDI Instruments

When a MIDI or Instrument track that is routing 
MIDI data to an instrument plug-in is record-en-
abled, Pro Tools automatically suspends Delay 
Compensation through the main outputs of the 
audio track, Auxiliary Input, or Instrument track 
on which the instrument plug-in is inserted. This 
allows for latency-free monitoring of the instru-
ment plug-in during recording.

Delay Compensation for virtual MIDI in-
struments works only when all MIDI and 
audio connections take place inside 
Pro Tools. While Pro Tools does not 
suspend Delay Compensation when you are 
using ReWire to connect software synthesiz-
ers and samplers in other ReWire client ap-
plications (such as Reason), Pro Tools can-
not account for any latency within the 
ReWire client itself.



MIDI and Audio Processing Plug-ins

Some audio processing plug-ins (such as Digide-
sign’s Bruno and Reso) and many instrument 
plug-ins let you process audio while allowing 
MIDI data to control processing parameters. 
When you record enable a MIDI or Instrument 
track that is controlling an audio processing 
plug-in, the track the plug-in is inserted on will 
go into low-latency mode, effectively making 
the processed audio play early. The steps to pre-
vent this and keep audio time-aligned depend 
on the type of track on which the plug-in re-
sides. 

To keep audio time-aligned when recording using a 
MIDI controlled plug-in on an audio track:

� Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the audio track to apply Delay Com-
pensation. 

To keep audio time-aligned when recording using a 
MIDI controlled plug-in on an Auxiliary Input:

1  Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the Auxiliary Input to bypass Delay 
Compensation.

2  Enter the total system delay into the User Off-
set field.

Configuring Cue Mixes with Delay 
Compensation

If you already have a Pro Tools session that uses 
various plug-in inserts and mixer routing, you 
will most likely want to have Delay Compensa-
tion enabled. However, if you want to record 
overdubs with a recording artist, “the talent,” 
you will need to configure monitoring mixes 
(headphone or “cue” mixes). 
Use sends to bus cue mixes to audio output 
paths for headphone monitoring by the talent. 
In addition to the main mix, which will monitor 
in the control room, route track sends to one or 
more additional audio output paths tracks for 
cue mix monitoring. Using sends lets you con-
figure different mixes from the main mix for cue 
mix monitoring. For example, when recording a 
guitarist, they may want to hear themselves 
more in the cue mix than you will want to hear 
in the main mix.

Example configuration using sends for cue mixes:

1  Assign each track’s main output to your main 
mix outputs.

2  Assign a send (mono or stereo) for each track 
and set the send outputs to output paths 3 and 4 
on your audio interface. 

3  Enable the FMP (Follow Main Pan) button on 
all of the sends so that the cue mix has the same 
panning as the main mix.

4  Set all of the sends to unity and to post-fader. 
This lets you use the same mix for the talent, but 
also lets you boost (or attenuate) the level of the 
talent’s signal in the cue mix by adjusting the 
send level as needed.

5  Choose Track > New.

6  Specify the track type (Main Fader) and format 
(stereo), then click Create.

7  From the Master Fader track’s Output Path se-
lector, select output paths 3 and 4 for monitor-
ing the mix. 
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8  Adjust the Master Fader track’s fader to control 
the overall volume for the cue mix.

9  Repeat the preceding steps for additional cue 
mixes on additional outputs on your audio in-
terface as necessary.

Delay Factors
With Pro Tools HD, delay is incurred when you 
perform the following processes:

• Bouncing tracks. See “Bouncing Tracks” on 
page 96.

• Real-time processing with plug-in inserts. 
See “Using Plug-in Inserts” on page 96. 

• Mixing and routing with sends. See “Using 
Sends” on page 97.

• Mixing and routing with hardware I/O 
(sends or inserts). “Using Hardware Inserts 
or Sends” on page 97.

With Delay Compensation enabled, it is 
recommended that you do not use any in-
serts on any Auxiliary Input or Master 
Fader tracks you may be using to control the 
cue mix volume. Also, you should avoid us-
ing inserts on any record tracks. (Some low 
latency inserts may be acceptable depend-
ing on the talent’s preference.)
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Bouncing Tracks

Bouncing to tracks causes additional delay, as 
follows:

Bus-Based Bounces When you bus a track to an-
other track and record the result, the following 
delays are incurred:

With Delay Compensation enabled, Pro Tools 
automatically compensates for bus-based de-
lays.

Bounce to Disk The File > Bounce to > Disk com-
mand causes no delay on Pro Tools|HD systems, 
because Delay Compensation for the bounce 
function is built in. Because of this, Bounce to 
Disk may be more desirable than bus recording. 
For more information, see the Pro Tools Reference 
Guide. 

Using Plug-in Inserts

Using plug-in inserts on a track causes addi-
tional delay. 

With Delay Compensation enabled, Pro Tools 
can automatically compensate for delays due to 
plug-in inserts.

Bus-based bounce delays for each Pro Tools system

HD Mixer Delay 

Stereo Mixer 10 samples

Surround Mixer 8 samples

For specific information on the delay 
amounts for DigiRack or Digidesign plug-
ins, refer to your DigiRack Plug-ins Guide or 
Digidesign Plug-ins Guide.



Using Sends

When you send a track to another track and re-
turn it to a track (audio, Auxiliary Input, or Mas-
ter Fader), the following delays are incurred:

Hardware sends also produce delays (see below).

With Delay Compensation enabled, Pro Tools 
automatically compensates for delays due to 
sends.

Using Hardware Inserts or Sends

When an audio interface is used on an insert or 
send, there is delay introduced by going 
through the D/A and A/D converter pair (for an-
alog devices) or digital I/O connection (for digi-
tal devices) on the audio interface.

With Delay Compensation enabled, Pro Tools 
automatically compensates for these delays.

To compensate for the delay of any external 
hardware devices (such as an effects unit) that is 
used as a hardware insert in your session, you 
can set the amount of Delay Compensation (in 
milliseconds) for each external device. The con-
trols for setting hardware insert delay are located 
in the I/O Setup dialog. See the Pro Tools Refer-
ence Guide for more information.

Sends delays for Pro Tools|HD systems

HD Mixer Sends Delay

Stereo Mixer Pre-fader send to 
bus

10 samples

Post-fader send 
to bus

8 samples

Surround 
Mixer

Pre-fader send to 
bus

8 samples

Post-fader send 
to bus

12 samples
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appendix f

TDM Mixing and DSP Usage
Benefits of TDM II
Digidesign’s TDM (or time division multiplexing) 
technology is based on the concept of a single, 
high-speed data highway, or bus that transmits 
data between your Pro Tools CPU, Pro Tools 
cards, and the DSP chips on the cards.

Pro Tools|HD cards feature Digidesign’s en-
hanced TDM II architecture. The TDM II archi-
tecture provides many advantages over the orig-
inal TDM (or TDM I) architecture in terms of its 
mixing capacity and flexibility.

In TDM systems, individual channels from 
sources such as audio tracks, sends, or busses are 
sent out from Pro Tools audio cards, and com-
bined together or multiplexed onto the TDM bus 
so that all signals can travel simultaneously and 
can be accessed within a single sample period. 
At the receiving end, the audio cards can listen 
to any connection on the bus, and take what-
ever data they need.

The TDM bus runs fast enough to accommodate 
many audio signals at the same time. Each sepa-
rate audio signal or stream, takes up a single time 
slot on this multiplexed bus.

One of most powerful features of the TDM archi-
tecture is that a single time slot can be used to 
“broadcast” data to many destinations simulta-
neously. 
With TDM II, not only can it send data to many 
destinations simultaneously, but it can also 
send signals both bi-directionally and “pri-
vately” between DSP chips, which effectively 
provides a much greater number of available 
time slots. This provides a greater potential 
number of connections for routing, processing 
and mixing audio signals within Pro Tools.

TDM II

With TDM II, there is a separate TDM I/O bus be-
tween each DSP chip on the Pro Tools cards, 
each with up to 512 bi-directional time slots at a 
session sample rate of 44.1 or 48 kHz (both be-
tween DSPs on each card, and between the DSPs 
that communicate between cards). The DSP 
chips are arranged serially, with a TDM I/O bus 
connecting one chip to the next. This means 
that every TDM II connection need only use 
time slots between the two DSPs that are being 
connected. See Figure 11 on page 100.

So, using the same example as above, if an audio 
track has a Reverb One plug-in insert, a time slot 
is used between the Engine DSP (sending out the 
audio track) and the DSP with the Reverb One 
instance. If the Reverb One insert is handled by 
a DSP that is physically next to the DSP han-
dling mixing tasks, as shown in the illustration 
below, this leaves time slot 2 available for use 
between DSP 3 through DSP 9, and subsequent 
Pro Tools|HD cards. 
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The maximum consumption of the time slots 
for a single connection occurs when the audio 
must be sent between the first and last DSP in 
the system. In this instance, a time slot between 
each DSP is used to reach the last DSP in the 
chain.

Time slot usage on Pro Tools|HD hardware
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Another example of how TDM II is more effi-
cient than TDM I is to imagine a single HD Core 
card with one Engine chip and two Mixer chips. 
The DSPs with plug-in instances associated with 
the first Mixer do not need to communicate 
with the second Mixer, therefore the time slot 
numbers used can be re-used by the second 
Mixer to communicate with other DSPs loaded 
with other plug-ins.
Figure 11.  TDM bus on Pro Tools|HD hardware



DSP Allocation
Digital Signal Processing (or DSP) capability is 
one of the most powerful elements of your sys-
tem. The DSP chips in your system provide the 
real-time processing power for your TDM Mixer 
and plug-ins. There is a limit, depending on 
your system, to how many functions a single 
DSP chip can power at once. This section con-
tains some guidelines for getting the most from 
your available DSP capacity.

DSP Allocation Basics

As in the analog world, every send bus or output 
mix that you use demands that a summing 
mixer exist for that group. On an analog con-
sole, the number of these summing mixers is 
fixed by the physical layout of the console. In 
the Pro Tools mix environment, this number is 
variable, and depends on the number of output 
mixes or sends that you choose to create. 
Pro Tools allocates DSP power as it is needed to 
build the mixers for each session.

We describe certain mixing or signal processing 
functions as “using one DSP” or “using two 
DSPs.” This refers to the fact that there are 9 DSP 
chips on each HD card. 

Each chip on a card can only power a certain 
number of processing functions. If you have a 
single Pro Tools|HD card, and you create a big 
enough TDM mixer and use enough sends or 
plug-ins, you will eventually use up or “max 
out” the DSP capacity of that card.
Mixing and DSP Usage

Pro Tools builds a TDM mixer every time a ses-
sion is opened. Note that the term “mixer chan-
nel” applies to audio tracks (total voiceable 
tracks), Auxiliary Input tracks, and sends and re-
turns that use any of the 128 internal busses. 
When you go beyond a certain number of mixer 
channels, Pro Tools will use another DSP to cre-
ate additional mixer capacity. 

Master Faders do not use additional DSP power.

DSP Manager 

Pro Tools software includes the DSP Manager, a 
software component that optimizes the use of 
DSP capacity on Pro Tools|HD systems.

When you have an Pro Tools|HD card in your 
system, if your current DSP usage is approaching 
the capacity of the card, and you then try to add 
a mixer channel or assign a plug-in, the DSP 
Manager will automatically try to make room 
for the new mixer or plug-in on the 
Pro Tools|HD card. It does this by reallocating 
the existing TDM mixers and plug-ins to use the 
available DSP capacity on the Pro Tools|HD card 
as efficiently as possible. 
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Monitoring DSP Usage

The System Usage window provides a display of 
DSP usage. With these indicators as your guide, 
you can try different mixer setups and different 
arrangements of plug-ins, sends, and Auxiliary 
Inputs to maximize your use of available DSP 
power.

Pro Tools HD also maintains a Plug-in and Mixer 
cache for allocated DSP when closing and open-
ing sessions. While this does not change the 
time it takes to open the first session after you 
launch Pro Tools, it does result in being able to 
open and close all subsequent Pro Tools sessions 
quickly, especially when using the Revert To 
Saved command or when opening similarly con-
figured sessions.

As long as Pro Tools is running, the DSPs will 
only be completely purged if you open a session 
with a different sample rate or one with differ-
ent Playback Engine settings.

About Processing Bandwidth

Meters in the System Usage window indicate 
how much of your system’s processing power is 
being used in processing audio, and when writ-
ing and playing back automation.

As these meters approach their limits, native 
processing and recording, or playback of auto-
mation data can be affected. If CPU or PCI Activ-
ity are high, a system error may occur. If Disk 
Activity is high, Pro Tools may miss playback of 
some automation data during particularly dense 
periods of activity, such as while using the 
Bounce to Disk command.

System Activity Meters

PCI Displays the amount of PCI bus activity.

CPU (RTAS) Displays the amount of CPU pro-
cessing activity for RTAS processing.
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CPU (Elastic) Displays the amount of processing 
activity for Real-Time Elastic Audio processing.

Disk Displays the amount of hard disk process-
ing activity.

Additional Meters

TDM Voices Allocated  Displays the total num-
ber of TDM voices that can be allocated and the 
number of voices currently allocated. This in-
cludes all voices whether they are allocated 
explicitly or dynamically, as well as any voices 
used for routing RTAS processing.

TDM Time Slots Used Displays the total number 
of TDM Time Slots available and the number of 
TDM Time Slots currently used.

DSP Usage (Accel Core, HD Core, HD Accel, and 
HD Process) Displays the percentage of how 
much of each DSP chip on each Pro Tools|HD 
card is currently being used for mixer configura-
tions and TDM plug-ins.

To monitor the usage of DSP resources during a 
Pro Tools session:

� Choose Window > System Usage.

System Usage window

DSP

Usage

System

Activity

TDM

DSP

Cache



DSP Cache

Pro Tools HD also maintains a Plug-in and Mixer 
cache for allocated DSP when closing and open-
ing sessions. While this does not change the 
time it takes to open the first session after you 
launch Pro Tools, it does result in being able to 
open and close all subsequent Pro Tools sessions 
quickly, especially when using the Revert To 
Saved command or when opening similarly con-
figured sessions.

As long as Pro Tools is running, the DSPs will 
only be completely purged if you open a session 
with a different sample rate or one with differ-
ent Playback Engine settings.

When using DSP caching, the System Usage 
window may not always accurately show the 
DSP resources your session is currently using. 
For an accurate display of current DSP usage, 
you can either disable DSP caching or purge the 
DSP cache.

To enable (or disable) DSP Caching:

1  Open the System Usage window (Windows > 
System Usage).

2  Click the DSP Cache pop-up menu and select 
(or deselect) Use DSP Cache.

To purge the DSP cache:

1  Open the System Usage window (Windows > 
System Usage).

2  Click the DSP Cache pop-up menu and select 
(or deselect) Purge Cache. This refreshes the Sys-
tem Usage display.

Another feature available for DSP manage-
ment is Active and Inactive switching. See 
the Pro Tools Reference Guide for more in-
formation.
Setting Up Sessions to Use DSP 
Efficiently

The dynamically configurable mixing environ-
ment in Pro Tools lets you make choices based 
on the type of setup you want to have—such as 
how many inputs you want for your mixer, how 
many plug-ins you want to use, or how many 
sends you need.

For example, you could allocate all of your DSP 
power to create a large mixer with dozens of 
channels—but you would not be able to use as 
many busses, sends, or TDM plug-ins. Alterna-
tively, you could create a mixer with a smaller 
number of mixer channels plus some sends and 
Auxiliary Inputs for returns, and TDM plug-ins 
on several tracks.

You can set up your session by choosing one of 
the session templates supplied with your system 
as a starting point, or by building it from 
scratch. If you are starting from scratch, a good 
rule of thumb is to start by building your mixer 
first, since at least one of the DSPs in your sys-
tem is automatically dedicated to mixing. Start 
with audio tracks, then add sends and Auxiliary 
Inputs, and finally add plug-ins as available DSP 
allows. Master Faders do not use additional DSP 
power. 

RTAS (Real-Time AudioSuite) plug-ins, as 
well as AudioSuite plug-ins, do not use DSP 
and are always available. Refer to your Di-
giRack Plug-Ins Guide for more information.
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DSP Usage and Mixer Plug-Ins

Understanding Mixers

Pro Tools|HD systems include two mixer plug-in 
“flavors:” stereo and surround (both of which 
are available with dither or without). Pro Tools 
uses these plug-ins to create “dynamic mixers,” 
meaning that the mixer size can expand or con-
tract as mix channels are added or deleted in 
Pro Tools. More channels take up more DSP 
power from your Pro Tools hardware. This is dif-
ferent from hardware mixing consoles where 
hardware (analog or digital) creates “fixed” mix 
configurations consisting of an unchangeable 
number of master outputs, busses or sends.

DSP allocation for mixing in a Pro Tools|HD sys-
tem is based on the concept of DSP summing 
mixers. Every send bus or output mix that you 
use requires that a summing mixer exists for 
those signals. Every single signal path that is 
mixed together requires the use of a mixer plug-
in (whether a main output that goes to hard-
ware, a bus or a send). This is even true for an in-
dividual signal that travels from hard disk to an 
individual hardware output. These individual 
dynamic mixers are created using the appropri-
ate TDM mixer plug-in (stereo or surround) that 
is installed in your Plug-Ins folder.

An “input” can be an audio track, send, or inter-
nal bus connection. Adding an output or bus 
path (mono or multichannel) adds the require-
ment for DSP power to mix the signals together.

Each Pro Tools|HD card has nine DSPs, which 
can power a certain number of signal processing 
tasks. DSP resources are dynamically allocated as 
the number of mixers and inputs increases. 

The TDM mixer provides basic building blocks 
by which applications such as Pro Tools can cre-
ate a wide variety of mixer configurations.
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Mono and Stereo

Each TDM mono or stereo mixer is of the di-
mensions “N x 2,” meaning that it mixes a vari-
able number of inputs to an output pair. For ex-
ample: A session with six tracks routed to 
Output 1–2 would require a single 6 x 2 mixer. If 
one of the six tracks is assigned to Output 3–4, 
however, two mixers are required—one 5x2 
mixer routed to Output 1–2, and one 1x2 mixer 
routed to Output 3–4.

Multichannel Surround

Each Surround mixer can have a variable num-
ber of outputs as well as a variable number of in-
puts. For example, the 7.1 format requires eight 
outputs. A single mono track assigned to a 7.1 
Output or Bus path would require a 1x8 mixer, 
while one mono and one stereo track assigned 
to a 7.1 Output or Bus path would require a 3x8 
mixer. 

The important concept here is that every output 
(whether they are I/O or bus outputs) requires 
that a mixer exists for that output. This means 
that creating a send to bus 1 requires that a 
mixer be created for the bus 1–2 outputs, and 
that mixer will have one input.

Mixing with Sends and Busses

Each send will add an input to the destination 
output pair. For example, a send to output 1 will 
add another input to the output 1–2 mixer. If 
the send destination doesn’t already have a 
mixer for its output pair, then a new mixer will 
be created. A send to bus 3 will make a 1x2 mixer 
for bus 3 if no other bus 3 sources have been cre-
ated yet.

In addition, adding a new track and assigning its 
input to a bus source will create a mixer for that 
bus pair if there is not one already. 



For example, creating a new Auxiliary Input 
track and setting its input to bus 5 will create a 
1x2 mixer for bus 5, even if no sources have 
been created yet. 

Submixing

When the number of channels that must be 
mixed exceeds the capacity of a single DSP, ad-
ditional “main” mixers are created automati-
cally, along with summing submixers (which 
sum together the “main” mixers). The use of 
submixers allows large mix configurations to be 
created.

For example, on a Pro Tools|HD system, when a 
Stereo mixer running at 44.1 kHz needs to grow 
to more than 68 inputs, a submixer is created 
along with another “main mixer” that provides 
“n” number of inputs beyond 68. Both the orig-
inal 68x2 mixer and the new “N x 2” mixer 
which provides additional inputs are routed to a 
submixer, and its outputs are finally sent to the 
desired destination (such as Output 1–2 on your 
main audio interface).

Note that any small delays (on the order of a few 
samples) that are created remain equal between 
these main mixers because they are summed to-
gether by means of submixers, and are not cas-
caded.

The total number of voiceable tracks supported 
by your particular Pro Tools configuration will 
ultimately determine the maximum number of 
channels for your TDM mixer.

Mixers and DSP Hardware

Different mixer plug-ins are available, each of 
which uses DSP power at slightly different rates 
on the different audio cards (and their DSP 
chips), as shown in the following tables. 

See “Mixer Plug-ins” on page 108.
In Pro Tools|HD systems, the number of avail-
able mixers per DSP chip is based on the type of 
card and session sample rate.

HD Accel (for PCI or PCIe) card, Standard mixers

Mixer
Sample Rate 
(kHz)

Usage per Chip

Stereo 44.1 and 48 124x2

88.2 and 96 54x2

176.4 and 192 16x2

Surround, 5.1 44.1 and 48 46x6 

88.2 and 96 34x6

176.4 and 192 8x6

Surround, 7.1 44.1 and 48 34x8

88.2 and 96 25x8

176.4 and 192 4x8

HD Accel card (for PCI or PCIe), Dithered mixers

Mixer
Sample Rate 
(kHz)

Usage per Chip

Stereo 
Dithered

44.1 and 48 113x2

88.2 and 96 54x2

176.4 and 192 16x2

Surround
Dithered, 5.1

44.1 and 48 44x6 

88.2 and 96 27x6

176.4 and 192 8x6

Surround
Dithered, 7.1

44.1 and 48 34x8

88.2 and 96 20x8

176.4 and 192 4x8
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HD card (for PCI), default Standard mixers

Mixer
Sample Rate 
(kHz)

Usage per 
Chip

Stereo 44.1, 48 68x2

88.2, 96 44x2

176.4, 192 16x2

Surround, 5.1 44.1, 48 22x6

88.2, 96 12x6

176.4, 192 4x6

Surround, 7.1 44.1, 48 16x8

88.2, 96 8x8

176.4, 192 2x8

HD card (for PCI), Dithered mixers

Mixer
Sample Rate 
(kHz)

Usage per 
Chip

Stereo 
Dithered 

44.1, 48 56x2

88.2, 96 34x2

176.4, 192 14x2

Surround 
Dithered, 5.1

44.1, 48 19x6

88.2, 96 10x6

176.4, 192 1x6

Surround
Dithered, 7.1

44.1, 48 15x8

88.2, 96 7x8

176.4, 192 not supported
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48-Bit Mixing Precision 

The Pro Tools mixer plug-ins use a register area 
inside of the DSPs on the hardware to hold a full 
48-bits of precision when mixing signals to-
gether. This allows a fader to be lowered in level 
without any loss of resolution. (Even if the fader 
is lowered almost to the bottom, all 24 of the 
original 24 bits of the signal are preserved.)

Mixer Headroom

Use of 48-bit precision when mixing allows the 
mixer to be designed to provide a very large 
amount of headroom, which allows the faders 
on the Pro Tools mixer to be placed in the 
“sweet spot” position without clipping. 

Mixer plug-ins provided with Pro Tools|HD sys-
tems provide 48-bit precision with 48 dB of 
headroom. This means that on the “input” side 
of the bus (where signals are summed together), 
signals can never clip (even if channel faders are 
set to a full +12 dB of gain).

However, the “output” side of the summing 
mixer (where the signal is sent in the 24-bit 
world of a digital output or onto the TDM bus) 
can clip. You can use a Master fader (which does 
not “cost” any DSP) to scale the output level of 
any mix summing point (a bus or physical out-
put). The master fader's meters will tell you if 
you are clipping the mix bus, and the fader can 
be used to safely scale the level to avoid clip-
ping, with no loss of quality.

If you are mixing larger numbers of signals 
together, always use a master fader so that 
you can monitor levels for the bus (using the 
master fader meter), and to trim the result to 
avoid clipping. Since Master faders cost no 
DSP, there is no reason not to use them.



Note that clipping the “input” side of a mixer is 
not a concern on Pro Tools|HD systems. It is vir-
tually impossible to clip the input of any 
Pro Tools|HD mixer plug-in, because the 48 dB 
of headroom provided prevents any possibility 
of overload, even with a maximum number of 
inputs being fed by full-code signals with fader 
gains at maximum. While it is possible to clip 
the “output” side of the mixer, you can safely 
use a Master Fader to trim your mix bus back to 
avoid clipping (by simply examining the Master 
Fader meter for clipping, and pulling back the 
fader until it disappears; make sure that any 
plug-ins you may have on the Master Fader in-
serts are not the cause as well). The 48-bit preci-
sion of the mixer allows gain adjustment on the 
Master Fader with no loss of data integrity or au-
dio quality, so there is no need to trim the indi-
vidual input faders back to avoid clipping.

Mixer Automatiion

Volume automation on all mixer versions is 
near sample-accurate (as is pan automation on 
the stereo versions). In addition, DAE provides 
24-bit interpolated values between mix break-
points, which provides near “analog-like” reso-
lution. This process of interpolation means that 
a smooth “data series” is created between any 
two breakpoints that you specify in Pro Tools. 
DAE calculates these smooth transitions on the 
DSP hardware with 24-bit precision, which pro-
vides extremely smooth volume changes. In ad-
dition, DAE “de-zippers” any “live input” to the 
mixer so that fast, real-time fader changes that 
come in from fader movements (on the Pro Tool 
user interface or control surfaces), do not cause 
audible artifacts as the mixer tries to “catch up” 
to fast changes that it receives.
Stereo and Surround Dithered 
Mixers

The Stereo Dithered and Surround Dithered 
mixer plug-ins provide non-correlated dither in 
addition to other basic attributes of the mixers 
described above. Every output summing point 
(whether to an internal bus or an physical out-
put) is dithered in these mixers. This technique 
is used to avoid any possibility of audible arti-
facts caused by truncation of extremely low 
level data that occurs when signals pass from the 
48-bit world of a TDM mixer to the 24-bit world 
of a TDM bus connection or a hardware output. 
Any material that is truncated, lies below 
–144 dBFs (reflecting 24-bit of dynamic range). 

There is dissension in the audio community as 
to whether or not artifacts that fall within this 
area are actually audible in some way. (The nor-
mal dynamic range of human hearing is gener-
ally accepted to fall within a range of around 
120 dB, from the threshold of audibility to the 
threshold of pain.) 

Digidesign has developed a mixer that provides 
all of the benefits of the standard stereo and sur-
round mixer plug-ins, but also provide uncorre-
lated dither on any summed output. This pro-
vides a steady dither “noise floor” at extremely 
low level, which causes any truncation artifacts 
to be converted into steady white noise. How-
ever, the addition of uncorrelated dither re-
quires more DSP horsepower. As a result, the 
channel instance count from the dithered ver-
sions of the mixers is around 15% lower (or 
more) than the non-dithered standard versions 
(this varies with sample rate and mixer type). 
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For this reason, we offer both types of mixer 
plug-in. You may want to use the standard non-
dithered mixer in most applications because of 
its greater efficiency (allowing you to mix more 
channels without running out of DSP power), or 
the dithered mixer because of its theoretical ad-
vantages. 

A Note About Dithering to 16-Bit 
and Dither Plug-ins

The Dithered mixers provide 24-bit dither at 
their summing points. When creating a final 
mix that results to 16-bits (for example, for CD 
mastering), final dithering should still be han-
dled by plug-ins that provide dither. To properly 
dither the final mix result, insert a dither plug-in 
on the post-fader inserts of a Master fader. De-
tails about dither and proper usage of the dither 
plug-ins can be found in the Pro Tools Reference 
Guide.

Mixer Plug-ins

Pro Tools|HD systems come with four different 
mixers: Stereo, Surround, Stereo Dithered, and 
Surround Dithered. 

The standard Stereo and Surround Mixer plug-
ins are installed by default. When you run your 
Pro Tools Installer, a copy of the Stereo Dithered 
and Surround Dithered mixers are placed in the 
folder “Plug-ins (Unused).” 
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Plug-in Features

Standard Surround and Stereo Mixers

Both the Surround and Stereo Mixer plug-ins 
provide the following:

• 24-bit digital output, from an audio inter-
face output or Bounce to Disk. Mix level 
scaling stores 48-bit results, using a 56-bit 
accumulator for maximum precision.

• 48 dB of mix headroom.

• Output clip indication.

• Multichannel mixing formats for surround 
(Surround Mixer only).

Surround Dithered and Stereo Dithered 
Mixers

Both the Surround Dithered and Stereo Dithered 
Mixer plug-ins provide the following:

• The same features as the standard 
Pro Tools|HD Stereo and Surround mixers, with 
the addition of non-correlated dither to any out-
put or bus send.

When using Dolby Digital encoders or 
Dolby E, you can only use the non-dithered 
mixer. The Dithered mixer will not allow 
proper playout of Dolby Digital or Dolby E 
out of an output.



Switching Mixer Plug-ins

To switch TDM Mixer plug-ins:

1  Quit Pro Tools.

2  Do one of the following:

• On Windows systems, open the “Plug-ins 
(Unused)” folder (Program Files\
Common Files\Digidesign\DAE).

– or –

• On Mac systems, open the “Plug-ins (Un-
used)” folder on your Startup drive 
(Library/Application Support/Digidesign).

3  Locate the Mixer plug-in that you want to use, 
and drag it to the Plug-ins folder.

4  Open the “Plug-ins” folder, locate the Mixer 
plug-in version that you no longer want to use, 
and drag it to the “Plug-ins (Unused)” folder.

5  Launch Pro Tools.

Mixer Usage Guidelines

The following conditions apply to mixing with 
Pro Tools|HD systems.

� One DSP chip is automatically dedicated to 
mixing in the TDM environment.

� As you reach the basic mixer limits for a single 
DSP chip, the system will automatically begin 
allocating DSP resources from another chip (if 
available), making it unavailable for plug-ins. 

� Each bus or send connection requires DSP to 
mix signals. This means that each send or Aux-
iliary Input that you create will require DSP 
power to mix the results.
DSP Usage with TDM Plug-Ins
To get the best results when using TDM plug-
ins, keep in mind the following guidelines 

� Pro Tools|HD systems use Digidesign’s Multi-
Shell™ technology, that lets any MultiShell 
compatible plug-in share DSP chips HD cards. 
Up to five types of MultiShell compatible plug-
ins can share a single DSP chip.

� Stereo DSP plug-ins generally use up twice as 
much DSP as mono plug-ins.

� Master Faders do not require additional DSP. 
Use them freely to control submix levels, 
send/bus output levels, and the master output 
level of your session.

The session templates provided with your sys-
tem include several useful preconfigured session 
setups that make efficient use of DSP resources. 

If your computer has unused slots, you can al-
ways increase your available DSP resources by 
adding additional HD cards to your 
Pro Tools|HD system.

Refer to the DigiRack Plug-Ins Guide for de-
tails on MultiShell plug-ins.
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appendix g

Troubleshooting
Backing Up Your Work
It is highly recommended that you back up your 
work on a regular basis, and especially before 
making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. 
There are a variety of media that are suited to 
back up projects of various sizes, from auto-
mated tape backup systems to high-capacity op-
tical drives, to CD/DVD burners.

The best way to back up an entire session is to 
use the Save Copy In command. This command 
lets you save the session file and all of its associ-
ated files to a new location.

You can also use the Auto Save Backup fea-
ture (in the Operation Preferences page) to 
have Pro Tools automatically save backups 
of the session file while you work.
Backing Up Your System 
Configuration

After configuring your system and Pro Tools, 
you should save an image of your system drive 
using a backup utility such as Norton Ghost 
(Windows) or Bombich Carbon Copy Cloner 
(Mac). By doing this, you can quickly restore 
your system configuration and settings if you 
encounter any problems.

Common Issues

Pro Tools Won’t Launch

Problem

When you double-click the Pro Tools applica-
tion or a Pro Tools session file, Pro Tools doesn’t 
launch, or displays an error message. 

Possible Solutions

� Check to be sure your computer has the re-
quired amount of RAM to launch Pro Tools. 
Refer to the Digidesign website
(www.digidesign.com/compatibility).

� Try a complete restart. Turn off your audio in-
terfaces, computer peripherals and your com-
puter, and then turn them on again in the 
proper sequence.
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� If you tried to launch Pro Tools by double-
clicking a Pro Tools session file, do the follow-
ing:

• Close any error message.

• Double-click the Pro Tools application.

• In Pro Tools, choose File > Open Session to 
open the session.

� Reinstall the Pro Tools application, using the 
Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem

When you launch Pro Tools it does not recog-
nize an audio interface, or a connected audio in-
terface is not available.

Possible Solutions

� Turn off your computer and check to be sure 
your cables are properly and securely connected 
to your computer and to your audio interface.

� Verify that your Hardware Setup dialog set-
tings are correct.

� If you only have one interface, make sure it is 
connected to the Accel Core (for PCIe) or HD 
Core (for PCI) card.

� Make sure Loop Sync, SuperClock or other 
synchronization connections to your audio in-
terface are correct. Disconnect the clock source 
from the interface and see if the problem per-
sists.
Pro Tools|HD Setup Guide
Using DigiTest as a Diagnostic 
Tool
The DigiTest utility performs diagnostic tests on 
the Pro Tools cards in your system. If DigiTest 
reports that any of your cards have failed, click 
the Info button next to that card. Write down 
the information that appears and report it to 
your local Digidesign dealer or to Digidesign 
Technical Support. 

Performance Factors
There are several conditions that may adversely 
affect the performance of Pro Tools. These in-
clude:

Network Connections Close any network con-
nections unless you are using them for network 
interchange of audio data.

Background Applications Any software utilities 
that run in the background or generate disk ac-
tivity, such as virus protection, disk optimiza-
tion, or file savers, should be turned off or re-
moved.

Screen Savers Screen saver software should be 
completely disabled on your computer before 
running Pro Tools.

Power Saver Features Some automatic power 
saver features, such as those that spin down the 
system hard drive, can affect Pro Tools perfor-
mance. These features should be turned off.



Before You Call Digidesign 
Technical Support

Register Your System

Register your purchase immediately after re-
viewing the Digidesign Registration Informa-
tion Card included with every Pro Tools system. 
Registering your purchase is the only way you 
become eligible to receive complimentary tech-
nical support and future upgrade offers. Regis-
tering is one of the most important steps to 
complete as a new user.

Gather Important Information

Digidesign wants to help you resolve problems 
as quickly and efficiently as possible. If you have 
the following information handy when you 
contact Technical Support, it will make the diag-
nosis of your problem easier. Take a few minutes 
to collect the following basic information:

System Information

Computer

• Make, model, processor speed

• Amount of system RAM

• Operating system (version of Windows or 
Mac OS)

• Any Drivers, Disk Utilities, or other system-
related applications you may have installed

Digidesign Hardware

• Type of cards, interfaces, or peripherals

• Where the cards are installed

• PCI or PCIe card order in computer or chas-
sis

• Interfaces connected to each card
Hard Drives

• Make, Model

• Drive size (GB)

• Drive speed (RPM)

• Drive type (SCSI, FireWire, IDE/ATA)

• Utility used to format the drive

• Number and size of partitions on the drive

Digidesign Software

• Pro Tools software version

• Plug-in versions

• Other Digidesign software

• Additional plug-ins from Digidesign Devel-
opment Partners

Other Hardware

Refer to the manufacturer’s documentation for 
operational details. 

The most common hardware additions include:

• SCSI host bus adapter (HBA) cards (manu-
facturer, model, settings)

• 1394 (FireWire) cards for Windows systems 
(manufacturer, model)

• Expansion Chassis (manufacturer, model, 
bridge chip type)

• Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use 
with your Pro Tools system, refer to the Digide-
sign website (www.digidesign.com).

Other Software

If you are using other audio or video applica-
tions, refer to the manufacturer’s documenta-
tion for operational details.

Make note of any other software that was run-
ning when a problem occurred.
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Diagnostic Information

DigiTest

If you run DigiTest, be sure to make a note of 
any error codes or messages it generates. 

Other Information

Note any DAE errors or other error codes you en-
counter. Additionally, note the ability to repro-
duce the problem under different conditions, 
for example, with another session, or after 
changing settings (such as the Hardware Buffer 
Size). 
Pro Tools|HD Setup Guide
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Resources
Whether you are new to Pro Tools or just start-
ing out with your new system, we encourage 
you to read and utilize the many guides that Pro 
Tools provides. There are also useful online re-
sources available, giving you everything from 
Pro Tools tips to Pro Tools answers.

About the Pro Tools Guides
In addition to any printed guides included with 
your system, PDF versions of the printed guides 
and many additional Pro Tools guides and Read 
Mes are installed automatically during Pro Tools 
installation. The Digidesign PDFs are located in 
the Digidesign/Documentation folder on your 
local drive.

Printed Setup Guide

This printed HD Setup Guide for your system 
gives you detailed instructions for setting up 
and configuring software and hardware for opti-
mum performance.

Printed copies of the Pro Tools Reference 
Guide and other guides in the Pro Tools guide 
set can be purchased separately from the 
DigiStore (www.digidesign.com).
Printed Pro Tools Reference Guide

The printed Pro Tools Reference Guide provides 
detailed descriptions of all Pro Tools software 
features, as well as helpful workflows for per-
forming tasks in Pro Tools.

Printed Expanded Systems Guide

The printed Expanded Systems Guide provides in-
structions for expanding a Pro Tools|HD system 
with additional Digidesign cards and audio in-
terfaces, with or without an expansion chassis.

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from 
the Pro Tools Help menu. (Choose Help, then se-
lect a guide.)

These include:

• Shortcuts Guide, which provides a complete list 
of keyboard and Right-click shortcuts for Pro 
Tools.

• DigiRack Plug-ins Guide, which describes the 
DigiRack plug-ins included with Pro Tools for 
both real-time and file-based audio process-
ing.

• Pro Tools Menus Guide, which covers all the 
Pro Tools on-screen menus.

• Pro Tools Reference Guide, which explains 
Pro Tools software in detail. 
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Documentation Installed 
Automatically with Pro Tools

When you install Pro Tools, you get useful PDF 
versions of many Pro Tools guides and 
Read Mes. This documentation can be found in 
the following locations:

Mac Applications/Digidesign/Documentation

Windows  C:\Program Files\Digidesign\Docu-
mentation

Read Me Files

These contain late-breaking information and 
known issues pertaining to Pro Tools software 
and hardware configurations. Read Me files are 
installed in Documentation folder when you in-
stall Pro Tools.

About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools system. 
The following are just a few of the services and 
features available. 

Product Registration Register your purchase on-
line. 

Support and Downloads Contact Digidesign 
Technical Support or Customer Service; down-
load software updates and the latest online 
manuals; browse the Compatibility documents 
for system requirements; search the online 
Answerbase; or join the worldwide Pro Tools 
community on the Digidesign User Conference. 

To view or print PDF guides, you can use 
Adobe Reader or Apple Preview (Mac only).
Pro Tools|HD Setup Guide
Training and Education 

Study on your own using courses available on-
line or find out how you can learn in a class-
room setting at a certified Pro Tools training 
center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of 
free tutorial videos. Accelerated Videos are de-
signed to help you get up and running with 
Pro Tools and its plug-ins quickly.

Helpful Online Resources

Once you get going, here are some helpful on-
line resources:

• Get useful information, help, and tips from 
the worldwide community of Pro Tools users 
at Digidesign User Conference (DUC). Go to: 
http://duc.digidesign.com

• For questions about installation, visit 
Digidesign’s online Answerbase. Go to: 
http://www.digidesign.com/answerbase

• If you can’t find your answer on the DUC or 
Answerbase, contact Digidesign 
email support. Go to:
http://www.digidesign.com/tsr
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DigiSerial port 3, 4
digital signal processing (see DSP)
DigiTest 38

troubleshooting 39
DMA option (Windows), enabling 57
drive formatting

Mac 77
Windows 76, 77

drive maintenance 75
drive requirements 8
DSP 101

allocating 101, 103
and Auxiliary Inputs 109
and Master Faders 109
and mixing 101
and TDM plug-ins 109
monitoring usage 102

DSP Cache 103
DSP delays 89

automatic compensation 45
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E
Energy Saver (Mac), turning off 60
error codes
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audio interfaces (Windows) 40

H
hard drives

drive formats 75
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